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1. Introduction to OPAC Parameters 

 
The Virtua Profiler lets you customize almost every feature of every subsystem in the 
VirtuaTM ILS – Integrated Library System. With the OPAC parameters, you can 
customize various aspects of the OPAC subsystem, most notably the information that 
appears on windows and screens in the Virtua client. In addition, you can configure 
the gathering of OPAC search statistics, sort order of selected item data, type of 
sorting you prefer for result sets, and size of the result set that the system returns after 
a keyword search.  
 
The Views in the OPAC parameters let you determine the display of bibliographic, 
holdings, item, and patron data in the Virtua client. The MARC View Editor, which is 
integrated into the Virtua Profiler, gives you an easy-to-use interface for editing more 
than 20 Client Views to suit local needs.  
 
The OPAC Basic Options parameter contains a variety of settings pertaining to 
managing OPAC searches in your system. 
 

Note: From this point on, we refer to the Virtua ILS – Integrated Library System as 
simply Virtua or the Virtua system in this user’s guide. 

 
This chapter covers the following topics:  
 

 Using this Guide 

 Accessing the OPAC Parameters 
 

1.1 Using this Guide 

 
The Virtua Profiler/OPAC Parameters User’s Guide provides step-by-step instructions for 
setting the parameters located on the OPAC tab of the Virtua Profiler. 
 
To locate specific information in this guide, use the list below and the table of 
contents. For your easy reference, the guide also offers a table of figures, an index, and 
a set of appendices. In addition, to facilitate navigation, we have placed at the 
beginning of each chapter a list of topics that are hyperlinked to those sections 
included in the chapter. 
 
For: 
 

See: 
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Information about working with MARC View Records Chapter 2 

Instructions for using the MARC View Editor Chapter 3 

Instructions for setting basic options for OPAC searches Chapter 4 

Information about the validation process of the MARC 
View Editor 

Appendix A 

A list of major changes in this guide since the last version Appendix B 

 

1.2 Accessing the OPAC Parameters 

 
OPAC parameters are located on the OPAC tab of the Virtua Profiler. 
 
To access OPAC parameters, 
 
1. Log in to the Virtua Profiler and display the initial window (Figure 1-1). 
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Figure 1-1. Virtua Profiler - Initial Window 

 
2. Click the OPAC tab to view the OPAC parameters, double-clicking the “OPAC” 

heading to expand the "tree" (Figure 1-2). 
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Figure 1-2. List of OPAC Parameters on the OPAC Tab 

 
3. Double-click the OPAC parameter you want to access:  
 

 Double-click Client Keyword Search Filters to display two types of filter 
options, Formats and Nature of Contents, which you can set. 
-OR- 

 Double-click Client Views to display a list of View records (Figure 1-3) that are 
available for editing in the MARC View Editor. 
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Figure 1-3. Expanded Tree of Client Views 

 
To open a View record in the MARC View Editor to configure, double-click 
one of the Views in the list. 
-OR- 

 Double-click OPAC Basic Options to see the OPAC Basic Options window 
(Figure 1-4) where you can set a variety of options regarding OPAC searches. 
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Figure 1-4. OPAC Basic Options Window 

 
The settings on the OPAC Basic Options window are addressed in the section 
“Working with the OPAC Basic Options Parameter.” 
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2. Working with MARC View 

Records 

 
The Virtua client displays bibliographic, holdings, item, and patron data elements 
based on the tags, subfields, fixed fields, and other information defined in the Client 
Views. By modifying these MARC Views using the MARC View Editor, which is 
integrated into the Profiler, you can… 
 

 Determine the bibliographic or other information that appears on a screen in the 
Virtua client. 

 Add a Format to a View, which displays when the source record qualifies in terms 
of specified record Type(s) and Bib Lvl(s). 

 Determine the layout of the data elements in list boxes in the client. 

 Create custom labels, including translated labels, for the data that are displayed. 

 Determine the format of the data that are displayed. 

 Specify the tags/subfields that are hyperlinked in a View. 
 
This chapter covers the following topics: 
 

 Understanding Views and View Records 

 Available View Records 

 

2.1 Understanding Views and View 

Records 

 
A MARC View is a template, or set of rules, used by the Virtua client to determine the 
display of bibliographic, holdings, item, and patron data elements. For each window or 
screen that uses a View, such as the Serials Check-in window, the MARC View 
determines which elements of the source MARC record appear to the user and in what 
format and language. 
 
The rules of a MARC View are encoded in a MARC View record, which is stored in 
the Virtua database. Virtua is shipped with a number of MARC View records, each 
consisting of a default template, which you can edit using the MARC View Editor. 
Each View record within a set determines the display of one or more areas of the 
Virtua client. 
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Each MARC View record contains the following elements: 
 

 A default View for use when the View record does not include a customized View. 

 A default Format, which specifies no record Type or Bib Lvl. You can add 
Formats to a View, which do specify record Types and/or Bib Lvls as conditions 
for display of data elements in a source record. 

 A default Language, or translation. You can add new Languages, or translations, to 
Views as needed. 

 

Tip: When choosing which elements of a record that you want to appear on a window 
in the OPAC, consider the context in which the data will appear. For example, if your 
system is set up to use the 090 tag to sort records by call number and you want the call 
number to display on the List of Titles window, make sure that the 090 tag appears in 
the List of Titles View. 

 

2.1.1 Example of a Client Window Based on a View 
Record 
 
As an example of a client window where the View is based on a View record that is 
configured in the MARC View Editor, we have captured the Serials Check-in window 
in Figure 2-1. This window uses the Serials Check-in View record to determine what 
information displays in the header of the Expected and Received tabs. 
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Figure 2-1. Serials Check-in Window 

  
The header of the Serials Check-in window can display elements from both the serials 
bibliographic record and the holdings record. For the bibliographic elements to be 
displayed, they must be configured on the Primary Display tab of the Serials Check-in 
View record; for the holdings elements to be displayed, they must be configured in a 
Format that is added to the Serials Check-in View.  
 
To accommodate all View elements when more than five exist, the header will provide 
a scroll bar. (Headers on other windows may not offer a scroll bar, so the number of 
elements displayed in the View will be limited.)  
 
The language of the header labels, such as Title, depends on two things: whether the 
labels are translated in the MARC View Editor and whether that language is being used 
by Virtua. If the current language of the client interface matches a translation available 
for the View record, Virtua uses the labels for that language. If the current language is 
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not defined in the View record, Virtua uses the language of the labels in the default 
View. 
 

2.2 Available View Records  

 
The table below contains a list of View records available for editing in the MARC View 
Editor. The table lists the Client View record along with the name of the Virtua client 
window that uses the View.  
 
The data elements in a View are configured using different features of the MARC 
View Editor. You will find that the majority of data elements are configured on the 
Primary Display tab in the Editor. The two tables indicate for each View which 
feature(s) of the Editor can be used to configure that particular View. 
  
The sections that follow the tables provide more detail about each View record. 
 
TABLE OF CLIENT VIEWS 
 

Name of the Client View  
 

Part of MARC Editor 
Used to Configure the 
View 

Virtua Client Window 
Using the View 

List of Titles  Primary Display tab List of Titles (four lines of 
display only) 

View Bib Record: Holdings 
Header/Item Details  

Primary Display tab 
 
 
 
 
General Tabular Display tab 

View Bibliographic 
Record window - Header 
on Holdings tab (five lines 
of display only) 
 
View Bibliographic 
Record window - List box 
on Holdings tab 

View Bibliographic Record: 
Full Display 

Primary Display tab View Bibliographic 
Record window - Full tab 

Item Information Primary Display tab Item Information window - 
Header on all tabs (three 
lines of display only) 
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Name of the Client View  
 

Part of MARC Editor 
Used to Configure the 
View 

Virtua Client Window 
Using the View 

Serials Check-in Primary Display tab 
 
 
 
Format 

Serials Check-in window - 
Bib header information on 
all tabs 
 
Serials Check-in window - 
Holdings header 
information on all tabs 

Patron Information/Check-
out Renew 

Primary Display tab  Patron Information 
window - Card Format 
tab 

 Check-out/Renew 
window - Patron 
Information tab 

Order Line Editor/Add Order Primary Display tab  Order Line Editor - Bib 
Information tab 

 Add Order window - 
Title string in list box 

View Authority Record: Full 
Display 

Primary Display tab View Authority Record  - 
Full tab 

View Record/View Holdings 
Record: Items tab 

Primary Display tab 
 
 
 
 
 
 
 
 
Items Tabular Display tab 

 View Bibliographic 
Record window - 
Header on Items tab 
(five lines of display) 

 View Holdings Record 
window - Header on 
Items tab (five lines of 
display) 

 

 View Bibliographic 
Record window - List 
box on Items tab 

 View Holdings Record 
window - List box on 
Items tab 

Patron Activity: Checked Out Patron Activity Display tab Patron Activity tab - 
Checked Out page 

Patron Activity: Overdue Patron Activity Display tab Patron Activity tab - 
Overdue page 

Patron Activity: Billed Patron Activity Display tab Patron Activity tab - Billed 
page 

Patron Activity: Requested Patron Activity Display tab Patron Activity tab - 
Recalled page 
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Name of the Client View  
 

Part of MARC Editor 
Used to Configure the 
View 

Virtua Client Window 
Using the View 

Patron Activity: Recalled 
Overdue 

Patron Activity Display tab Patron Activity tab - 
Recalled Overdue page 

Patron Activity: Pending Patron Activity Display tab Patron Activity tab - 
Pending page 

Patron Activity: Pickup Patron Activity Display tab Patron Activity tab - 
Pickup page 

Patron Activity: In Transit Patron Activity Display tab Patron Activity Tab - In 
Transit page 

Patron Activity: Disputed Patron Activity Display tab Patron Activity tab - 
Disputed page 

Patron Activity: Waived Patron Activity Display tab Patron Activity tab - 
Waived page 

Patron Account Tab Patron Account Display tab Patron Account tab - All 
pages 

View Holdings Record: Full 
Display 

Primary Display tab 
 
 
 
Format 

View Holdings Record 
window - Bib header 
information on Full tab 
 
View Holdings Record 
window - Holdings header 
information on Full tab 

Patron Activity: Booked Patron Activity Display tab Patron Activity tab - 
Booked page 

Patron: Holdings Issue 
Routing List 

Primary Display tab Holdings Issue Routing 
List – patron information 
portion 

Patron: Check Out/Renew Patron: Check Out/Renew 
Display tab 

Check Out/Renew 
window – Item List box 

Patron: Check In Patron: Check In Display tab Check In window – Item 
List box 

*UNIMARC List of 
Titles.REC 

Primary Display tab List of Titles (four lines of 
display only) 

*UNIMARC View 
Bibliographic Record - Full 
Display.REC 

Primary Display tab View Bibliographic 
Record window - Full tab 

*MARC21 List of Titles.REC Primary Display tab List of Titles (four lines of 
display only) 
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Name of the Client View  
 

Part of MARC Editor 
Used to Configure the 
View 

Virtua Client Window 
Using the View 

*MARC21 View 
Bibliographic Record - Full 
Display.REC 

Primary Display tab View Bibliographic 
Record window - Full tab 

 
*Virtua uses the Views marked with an asterisk when a non-Virtua, Z39.50 server connection is 
being used. The UNIMARC Views come into play only if the preferred record syntax for the 
connection is set to "1.2.840.10003.5.1" (UNIMARC) in the Server Setup window in the Virtua 
client. Otherwise, Virtua uses the corresponding MARC 21 Views. The View records reside on your 
PC in the VTLS\Virtua\Catalog directory. You can open them in the MARC View Editor and 
customize them just as you can the other Views described in this guide, but their names and location 
must remain the same. 
 
 

2.2.1 List of Titles View Record 
 
Description: The List of Titles View record is used to display up to four lines of 
bibliographic information on the List of Titles window. 
 
Configuring: All settings for the List of Titles View record are configured on the 
Primary Display tab in the MARC View Editor (Figure 2-2). 
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Figure 2-2. MARC View Editor - List of Titles View Record 

 
Client Display: The List of Titles View record is used to display information on the 
List of Titles window (Figure 2-3). 
 
 



Virtua Profiler/OPAC Parameters (v. 16.1)  

 PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

16 

 

Figure 2-3. Virtua Client - List of Titles Window View) 

 
For each record in the List of Titles window, Virtua displays the first four elements 
configured in the View that exist in the source record. For example,  
 
If the List of Titles View record includes the following elements (in order): 
 

 Author 

 Title 

 Edition 

 Call Number 

 Note 

 Publication Information 

 Description 

 ISBN 
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-AND- 
 
If the displayed bibliographic record includes tags that meet the View’s criteria for: 
 

 Title 

 Call Number 

 Publication Information 

 Description 

 ISBN 
 
The List of Titles window will display the following fields for that record, in the 
following order: 
 

 Title 

 Call Number 

 Publication Information 

 Description 
 

2.2.2 View Bib Record: Holdings Header/Item Details 
View Record 

 
Description: The View Bib Record: Holdings Header/Item Details View record is 
used to display bibliographic MARC record information and a list of available holdings 
copies, or records, on the View Bibliographic Record window.  
 
Configuring: Settings for the View Bib Record: Holdings Header/Item Details View 
Record is configured in the MARC View Editor on… 
 
The Primary Display tab (header information only) (Figure 2-4)  
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Figure 2-4. MARC View Editor - View Bib Record: Holdings Header/Item Details View Record 

 
-AND- 
 
The General Tabular Display tab (list of holdings copies, or records) (Figure 2-5). 
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Figure 2-5. MARC View Editor - View Bib Record: Holdings Header/Item Details View Record - General Tabular 
Display 

 
Client Display: The View Bib Record: Holdings Header/Item Details View record is 
used to display bibliographic MARC record information and a list of available holdings 
copies, or records, on the Holdings tab of the View Bibliographic Record window 
(Figure 2-6). 
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Figure 2-6. Virtua Client - View Bibliographic Record Window - Holdings Tab  

 

 Information in the header of the Holdings tab of the View Bibliographic Record 
window is controlled by the settings configured on the Primary Display tab of the 
MARC View Editor. For information about working with the Primary Display tab, 
see the section “Editing the Primary Display Elements” in this user’s guide. 

 

 Information in the list box of the Holdings tab of the View Bibliographic Record 
window is controlled by settings configured on the General Tabular Display tab of 
the MARC View Editor. For information about working with the General Tabular 
Display tab, see the section “Editing the General Tabular Display Elements” in 
this user’s guide. 

 

2.2.3 View Bibliographic Record: Full Display View 
Record 

 
Description: The View Bibliographic Record: Full Display View record is used to 
display full bibliographic information on the View Bibliographic Record window. 
 
Configuring: Settings for the View Bibliographic Record: Full Display View record is 
configured on the Primary Display tab in the MARC View Editor (Figure 2-7).  
 

Primary 
Display 

tab 

General 
Tabular 
Display 

tab 
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If you want to specify a View for the Full tab of the View Notes Record (i.e., copy-
specific notes record) window, you can do so by configuring a copy-specific notes 
Format for the View Bibliographic Record: Full Display View. To do this, specify the 
Type as ‘l’ (lowercase ‘L’) and the Bib Level as ‘l’ (lowercase ‘L’). For details about 
configuring Formats, see the section “Working with Formats” in this guide. 
 
 

 

Figure 2-7. MARC View Editor - View Record: Full Display View Record 

 
Client Display: The View Bibliographic Record: Full Display View record is used to 
display bibliographic information on the Full tab of the View Bibliographic Record 
window (Figure 2-8). Tag 856, and other tags with subfields that are designated as 
search links on the View record, will also display in the header of the Full tab.  
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Figure 2-8. Virtua Client - Full Tab of the View Bibliographic Record Window 

 

2.2.4 Item Information View Record 
 
Description: The Item Information View record is used to display three lines of 
bibliographic information in the header of the Item Information window.  
 
Configuring: All settings for the Item Information View record are configured on the 
Primary Display tab in the MARC View Editor (Figure 2-9). 
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Figure 2-9. MARC View Editor - Item Information View Record 

  
Client Display: The Item Information View record is used to display bibliographic 
information in the header that appears on all tabs of the Item Information window 
(Figure 2-10). 
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Figure 2-10. Virtua Client - Item Information Window 

 
Only the first three View elements in the Tag Label Information list appear in the 
header of the Item Information window. 
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2.2.5 Serials Check-in View Record 
 
Description: The Serials Check-in View record is used to display both bibliographic 
and holdings information in the header that appears on both tabs of the Serials Check-
in window. The Serials Check-in window is designed to use the bibliographic 
information configured on the Primary Display tab of the MARC View Editor and any 
holdings information configured in a Format added to the Serials Check-in View 
record. 
 
Configuring: Bibliographic and holdings data on the Serials Check-in View record can 
be configured using two aspects of the MARC View Editor:  
 

 The Primary Display tab for the main View (Figure 2-11). 
 
 

 

Figure 2-11. MARC View Editor - Serials Check-in View Record 
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-AND- 
 

 The Primary Display tab for a Format View.  
 

On the Edit Formats window (Figure 2-12), you can define a Format Name and 
specify record Types and Bib Levels as conditions used to qualify a source record 
for the Format View. 

 
 

 

Figure 2-12. Edit Formats Window 

 
Then on the Primary Display tab for the specified Format, you can configure the View 
for the Format. Sample data elements for a Holdings Format are displayed in Figure 
2-13. 
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Figure 2-13. MARC View Editor - Serials Check-in View Record - Format 

 
For details on configuring Formats, see the section “Working with Formats” in this 
guide. 
 
Client Display: The Serials Check-in View record is used to display both bibliographic 
and holdings information in the header on both tabs of the Serials Check-in window 
(Figure 2-14).  
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Figure 2-14. Virtua Client - Serials Check-in Window 

 
If the header of the Serials Check-in window needs to display more than five elements, 
a scroll bar will appear to accommodate the other configured data. 
 

2.2.6 Patron Information/Check-out/Renew/Check-in 
View Record 

 
Description: The Patron Information/Check-out/Renew/Check-in View record is 
used to display patron information on several windows. The view allows you to 
include information taken from any tag in the patron MARC record. 
 
Configuring: All settings for the Patron Information/Check-out/Renew/Check-in 
View record are configured on the Primary Display tab in the MARC View Editor 
(Figure 2-15). 
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Figure 2-15. MARC View Editor - Patron Information/Check-out/Renew View Record 

 
Client Display: The Patron Information/Check-out/Renew/Check-in View record is 
used to display patron information on three windows: 
 

 Card Format tab of the Patron Information window (Figure 2-16). 
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Figure 2-16. Virtua Client - Patron Information Window 
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 Header of the Patron Check-outs tab of the Check Out/Renew window (Figure 
2-17). 

 
 

 

Figure 2-17. Virtua Client - Check-out/Renew Window 

 
-AND- 
 

 Header of the Check-In window (Figure 2-18). 
 



Virtua Profiler/OPAC Parameters (v. 16.1)  

 PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

32 

 

Figure 2-18. Check In Window 
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2.2.7 Order Line Editor/Add Order View Record 
 
Description: The Order Line Editor/Add Order View record is used to display 
bibliographic information for ordered items in the Acquisitions subsystem.  
 
Configuring: All settings for the Order Line Editor/Add Order View record are 
configured on the Primary Display tab in the MARC View Editor (Figure 2-19). 
 
 

 

Figure 2-19. MARC View Editor - Order Line Editor/Add Order View Record 

  
Client Display: The Order Line Editor/Add Order View record is used to display… 
 

 Bibliographic information that appears on the Bibliographic Information tab of the 
Order Line Editor window (Figure 2-20). 
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Figure 2-20. Virtua Client - Order Line Editor 

 
-AND- 
 

 The data that appears in the title string that is dragged and dropped in the Line 
Items list box on the Order window (Figure 2-21). 
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Figure 2-21. Virtua Client - Order Window 

 
 

2.2.8 View Authority Record: Full Display View Record 
 
Description: The View Authority Record: Full Display View record is used to display 
authority information on the View Authority Record window.  
 
Configuring: Settings for the View Authority Record: Full Display View record are 
configured on the Primary Display tab in the MARC View Editor (Figure 2-22). 
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Figure 2-22. MARC View Editor - View Authority Record: Full Display View Record 

 
Client Display: The View Authority Record: Full Display View record is used to 
display authority information on the Full tab of the View Authority Record window 
(Figure 2-23).  
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Figure 2-23. Virtua Client - Full Tab of the View Authority Record Window 

 

2.2.9 View Record/View Holdings Record: Items 
Header/Items Display View Record 

 
Description: The View Record/View Holdings Record: Items Header/Items Display 
View record is used to display bibliographic and item information.  
 
Configuring: Settings for the View Record/View Holdings Record: Items 
Header/Items Display View record are configured on two tabs in the MARC View 
Editor: Primary Display tab (header information) and Items Tabular Display tab (list 
box information) (Figure 2-24 and Figure 2-25). 
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Figure 2-24. MARC View Editor - View Record/View Holdings Record: Items Header/Items Display View Record 
– Primary Display Tab 
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Figure 2-25. MARC View Editor - View Record/View Holdings Record: Items Header/Items Display View Record 
– Items Tabular Display Tag 

 
Client Display: The View Record/View Holdings Record: Items Header/Items 
Display View record is used to display information in both the header and the list box 
on the Items tab of two different windows, the View Bibliographic Record and the 
View Holdings Record. Tag 856 and other tags, the subfields for which are designated 
as search links on the View record, will also display in the header of the Items tab.  
 

 View Bibliographic Record window - Items tab (Figure 2-26). 
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Figure 2-26. Virtua Client - View Bibliographic Record Window - Items Tab  

 
Header information on the Items tab of the View Bibliographic Record window is 
controlled by the settings configured on the Primary Display tab of the MARC View 
record. For information about working with the Primary Display tab, see the section 
“Editing the Primary Display Elements” in this user’s guide. 
 
Item information on the Items tab of the View Bibliographic Record window is 
controlled by settings configured on the Items Tabular Display tab of the MARC View 
record. For information about working with the Items Tabular Display tab, see the 
section “Editing the Items Tabular Display Elements” in this user’s guide. 
 

 View Holdings Record window - Items tab (e 2-27). 
 
 

 Items Tabular 
Display 

tab 

Primary 
Display 

tab 
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Figure 2-27. Virtua Client - View Holdings Record - Items Tab 

 
Header information on the Items tab of the View Holdings Record window is 
controlled by the settings configured on the Primary Display tab of the MARC View 
record. For information about working with the Primary Display tab, see the section 
“Editing the Primary Display Elements” in this user’s guide. 
 
Item information on the Items tab of the View Holdings Record window is 
controlled by settings configured on the Items Tabular Display tab of the MARC View 
record. For information about working with the Items Tabular Display tab, see the 
section “Editing the Items Tabular Display Elements” in this user’s guide. 
 

2.2.10 Patron Activity View Records 
 
Description:  Patron Activity View records are used to display information about 
specific patron activities on the Patron Activity tab in the Virtua client. The Patron 
Activity View records are as follows:  
 

 Patron Activity: Checked Out 

 Patron Activity: Overdue 

 Patron Activity: Billed 

 Patron Activity: Requested 

 Patron Activity: Recalled Overdue 

 Patron Activity: Pending 

 Primary             
Display 

tab 

Items Tabular 
Display  

tab 
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 Patron Activity: Pickup 

 Patron Activity: Disputed 

 Patron Activity: In Transit  

 Patron Activity: Waived 

 Patron Activity: Booked 
 
Configuring: Settings for each Patron Activity View record are configured on the 
Patron Activity Display tab in the MARC View Editor (Figure 2-28). 
 
 

 

Figure 2-28. MARC View Editor - Patron Activity: Checked Out View Record 

  
Client Display: Each Patron Activity View record is used to determine which 
columns appear on the individual page tabs (except the Summary page tab) of the 
Activity tab on the Patron Information window. For example, Figure 2-29 shows the 
column list that appears on the Checked Out page tab on the Patron 
Information/Activity tab in the Virtua client. 
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Figure 2-29. Virtua Client - Patron Information Window - Activity Tab - Checked Out Page 

 
Client Default Displays: For each patron activity page available on the Activity tab of 
the Patron Information window, certain columns are displayed by default. The table 
below describes the content of the default displays. 
 

 

Patron Activity Page Contents of Default Display 

Checked Out Barcode, Check-out Date, Due Date, Renew Date, Title, 
and Check-out Location 

Overdue Due Date, Call Number, Title, Last Notice Type, and Last 
Notice Count 

Billed Barcode, Due Date, Call Number, Title, and Last Notice 
Date 

Recalled Barcode, Due Date, Date Placed, and Title 

Recalled Overdue Due Date, Call Number, Title, Date Placed, Last Notice 
Type, and Last Notice Count 

Pending Barcode, Patron Position in Request Queue, Request 
Expiration Date, Request Type, and Title 

Pickup Barcode, “Hold Until” Date, Pickup Location, Title, and 
Notice Sent 

Disputed Barcode, Dispute Date, and Title 
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Patron Activity Page Contents of Default Display 

In Transit Barcode, Title 

Waived Barcode, Waive Date, and Title 

Booked Barcode, Booking Start Date/Time, Booking End 
Date/Time, Title. 

 

2.2.11 Patron Account Tab View Record 
 
Description:  The Patron Account Tab View record is used to display all types of 
patron account information on the Account tab in the Virtua client.  
 
Configuring: Settings for the Patron Account Tab View record are configured on the 
Patron Account Display tab in the MARC View Editor (Figure 2-30). 
 
 

 

Figure 2-30. MARC View Editor - Patron Account Tab View Record 
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Client Display: The Patron Account Tab View record is used to determine which 
columns appear on ALL the page tabs (except the Summary page tab) of the Account 
tab of the Patron Information window. For example, Figure 2-31 shows one of those 
page tabs, Overdue, on the Account tab. 
 
 

 

Figure 2-31. Virtua Client - Patron Information Window - Account Tab - All Pages 

 
Client Default Display: Certain columns on the Account tab will be displayed by 
default. They are Item Number, Title, Date Posted, Amount of Fee, and Balance. 
 

2.2.12 View Holdings Record: Full Display View Record 
 
Description: The View Holdings Record: Full Display View record is used to display 
both bibliographic and holdings information in the header of the View Holdings 
Record window. The View Holdings Record window is designed to use the 
bibliographic information configured on the Primary Display tab of the MARC View 
Editor and any holdings information configured in a Format View. 
 
Configuring: Settings for the View Holdings Record: Full Display View record can be 
configured using two aspects of the MARC View Editor:  
 

 The Primary Display tab for the main, default View (Figure 2-32). 
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Figure 2-32. MARC View Editor - View Holdings Record: Full Display View Record 

 
-AND- 
 

 The Primary Display tab for a Format View.  
 
On the Edit Formats window (Figure 2-33), you can define a Format Name and 
specify record Types and Bib Levels as conditions used to qualify a source record 
for the Format View. 
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Figure 2-33. Edit Formats Window 

 
Then on the Primary Display tab for the specified Format, you can configure the View 
for the Format. Sample data elements for a Holdings Format are displayed in Figure 
2-34. 
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Figure 2-34. MARC View Editor - View Holdings Record: Full Display View Record  (Format View) 
  
For details on configuring Formats, see the section “Working with Formats” in this 
guide. 
 
Client Display: The View Holdings Record: Full Display View record is used to 
display both bibliographic and holdings information in the header of the Full tab of 
the View Holdings Record window (Figure 2-35).  
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Figure 2-35. Virtua Client - Full Tab of the View Holdings Record Window 

 
Figure 2-35 displays holdings data elements because the source record meets the Type 
and Bib Level conditions of the Format created for the View Holdings Record: Full 
Display View. Note that tag 856 and other tags, the subfields for which are designated 
as search links on the View record, will also display in the header of the Full tab and 
need to be configured in the Holdings Format View.  
 

2.2.13 Patron: Holdings Issue Routing List View Record 
 
Description:  The Patron: Holdings Issue Routing List View record is used to display 
patron information on the printable Holdings Issue Routing List in the Virtua client.  
 
Configuring: Settings for the Patron: Holdings Issue Routing List View record are 
configured on the Primary Display tab in the MARC View Editor (Figure 2-36). 
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Figure 2-36. MARC View Editor - Patron: Holdings Issue Routing List View Record 

  
Client Display: The Patron: Holdings Issue Routing List View record determines 
which type of patron information appears in the routing list portion of the Holdings 
Issue Routing List window (Figure 2-37). Note that the header of the Holdings Issue 
Routing List window is not configurable. 
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Figure 2-37. Virtua Client - Holdings Issue Routing List Window 

 

2.2.14 Patron: Check Out/Renew View Record 
 
Description: The Patron: Check Out/Renew View record is used to display item 
information in the Item List box on the Check Out/Renew window.  
 
Configuring: All settings for the Patron: Check Out/Renew View record are 
configured on the Patron: Check Out/Renew Display tab in the MARC View Editor 
(Figure 2-38). 
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Figure 2-38. MARC View Editor – Patron: Check Out/Renew Display View Record 

 
 
Client Display: The Patron: Check Out/Renew Display View record is used to 
display information in the list box on the Check Out/Renew window (Figure 2-39).  
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 Figure 2-39. Virtua Client – Check Out/Renew Window View 

 
Item information on the Items List box of the Check Out/Renew window is 
controlled by settings configured on the Patron: Check Out/Renew Display tab of the 
MARC View record. This tab is identical to the Items Tabular Display tab in other 
views. For information about working with the Patron: Check Out/Renew Display 
tab, see the section “Editing the Items Tabular Display Elements” in this user’s guide. 

 

2.2.15 Patron: Check In View Record 
 
Description: The Patron: Check In View record is used to display item information in 
the Item List box on the Check Out/Renew window.  
 
Configuring: All settings for the Patron: Check In View record are configured on the 
Patron: Check In Display tab in the MARC View Editor (Figure 2-40). 
 

 Items Tabular 
Display 

tab 
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Figure 2-40. MARC View Editor – Patron: Check In Display View Record 

 
Client Display: The Patron: Check In Display View record is used to display 
information in the list box on the Check In window (Figure 2-41).  
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Figure 2-41. Virtua Client – Check In Window 

 
Item information in the Items List box of the Check In window is controlled by 
settings configured on the Patron: Check In Display tab of the MARC View record. 
This tab is identical to the Items Tabular Display tab in other views. For information 

 Items Tabular 
Display 

tab 
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about working with the Patron: Check In Display tab, see the section “Editing the 
Items Tabular Display Elements” in this user’s guide. 
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3. Working with the MARC View 

Editor 

 
The MARC View Editor is an external application that is designed to be integrated into 
the Virtua Profiler. It was developed to allow you to edit View records, which encode 
the rules that you configure to display specific elements of a record in the Virtua client. 
 
This chapter covers the following topics: 
 

 Launching the MARC View Editor 

 Aspects of the MARC View Editor 

 Configuring Views 

 Working with Formats 

 Working with Languages and Translations 

 

3.1 Launching the MARC View Editor 

 
You can use the MARC View Editor in standalone mode or in "database connection" 
mode. Standalone mode is useful when you need to translate or modify a local View 
record but do not have access to a database connection. In standalone mode, the Save 
button on a View record window is disabled. After editing a View record in standalone 
mode, you need to save your work by using the Save to File function from the File 
menu.  
 

3.1.1 Standalone Mode 
 
To launch the MARC View Editor in standalone mode, 
 
1. Log in to the Virtua Profiler. 
 
2. Click the File menu and choose MARC View Editor (Figure 3-1). 
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Figure 3-1. Virtua Profiler - File Menu 

 
The MARC View Editor window opens, displaying no data elements. 

 
3. Click the File menu and choose Open (Figure 3-2). 
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Figure 3-2. MARC View Editor - File Menu 

 
In the Open Existing .REC File dialog box, navigate to the Virtua 
Profiler/Views/Client directory (Figure 3-3). 
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Figure 3-3. Open Existing .REC File Dialog Box 

 
4. Select a local View record, say Item Information.REC, and then click the Open 

button. 
 

The Item Information View record appears (Figure 3-4), ready for editing. 
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Figure 3-4. MARC View Editor - Local View Record 

 
5. Edit the local View record. 
6. Save your work by clicking the File drop-down menu and then choosing Save to 

File. 
 

The View record is saved to the file Item Information.REC. 
 

3.1.2 "Connected" Mode 
 
To launch the MARC View Editor in "connected" mode, 
 
1. Log in to the Virtua Profiler and connect to a database. 
 
2. On the OPAC tab, double-click a Client View record, say List of Titles, from the 

Client Views tree (Figure 3-5). 
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Figure 3-5. Virtua Profiler - Client Views Tree 

 
-OR- 
 
Highlight the Client View record, right click, and then choose Modify. 
 
The List of Titles View record appears in the MARC View Editor (Figure 3-6) ready 
for editing. 
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Figure 3-6. MARC View Editor - Database View Record 

 
3. Edit the database View record. 
4. Save your work, either to the database or to a local file.  

 Save to the database by clicking the Save button. 
-OR- 

 Save to a local file by clicking the File drop-down menu and then choosing 
Save to File.  

 

3.2 Aspects of the MARC View Editor 

 
The MARC View Editor opens as a separate window consisting of six menus on the 
menu bar and four tabs, only one or two of which will be visible on any one View 
record. Using the menus and tabs, you can configure MARC View records in your 
database. Additionally, for each View record, you can configure one or more Formats 
for the View and, if appropriate one or more translations.  
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3.2.1 Menu Bar Options 
 
The menu bar of the MARC View Editor consists of six menus:  
 

 File - Provides options for opening and saving MARC View record files. 

 Edit - Provides standard copy/cut/paste editing options and access to the dialog 
boxes from which you can add, delete, or modify Format Views and translations. 

 Options - Controls the editing environment of the MARC View Editor. Tip: If 
you want to change the display and input font of the MARC View Editor, change 
the font on the Options menu of the Virtua Profiler. 

 Format - Lists available Format Views for the active View record. 

 Language - Lists available languages for the active View record. 

 MARC Format - If your database has multiple MARC formats enabled, lists 
available MARC formats for the active View record. 

 

3.2.1.1 File Menu 

 
The File menu (Figure 3-7) offers three selections: 
 

 Open - Lets you open existing View records stored on a local disk such as your 
PC’s hard drive. 

 Save to file - Lets you save the current View record to a local disk.  

 Exit - Closes the MARC View Editor. If you exit before saving your work, the 
MARC View Editor asks if you want to save your changes before exiting. 

 
 

 

Figure 3-7. MARC View Editor - File Menu 

 

3.2.1.2 Edit Menu 

 
The Edit menu (Figure 3-8) offers five selections: 
 

 Cut - Moves the selected text to the clipboard. 

 Copy - Copies the selected text to the clipboard. 

 Paste - Pastes the text stored in the clipboard to the active field. 
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 Edit Format List - Displays the Edit Formats window on which you can add, 
delete, or modify a list of Format Views. For information about configuring 
Formats, see the section “Working with Formats” in this user’s guide. 

 Edit Language List - Displays the Edit Languages window on which you add, 
delete, or rename languages for the View record. For information about working 
with languages in the MARC View Editor see the section “Working with 
Languages and Translations” in this user’s guide. 

 
 

 

Figure 3-8. MARC View Editor - Edit Menu 

 

3.2.1.3 Options Menu 

  
The Options menu (Figure 3-9) offers one selection: 
 
Delete Warnings - When checked, the system prompts users to confirm that they 
want to delete an item. It is useful to turn off this feature when you are deleting many 
data elements in the Editor. By default this option is checked. 
 
 

 

Figure 3-9. MARC View Editor - Options Menu 

 

3.2.1.4 Format Menu 

 
The Format menu (Figure 3-10) lists the Formats available for this MARC View record. 
The currently displayed Format View is identified by a bullet on the left side of this 
menu. By clicking an entry in this list, you can display other configured Format Views 
in the MARC View Editor.  
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Figure 3-10. MARC View Editor - Format Menu 

 

Note: You can edit the list of formats in the Format menu by using the Edit Formats 
window. For information on working with the Edit Formats window, see the section 
“Working with Formats” in this user’s guide. 

 

3.2.1.5 Language Menu 

 
The Language menu (Figure 3-11) lists the translations available for this MARC View 
record. The currently displayed language is identified by a bullet on the left side of this 
menu. By clicking an entry in this list, you can display other translations of the current 
View. 
 
 

 

Figure 3-11. MARC View Editor - Language Menu 

 

Note: You can edit the list of languages in the Language menu by using the Edit 
Languages window. For information on working with the Edit Languages window, see 
the section “Displaying and Using the Edit Languages Window” in this user’s guide. 
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3.2.1.6 MARC Format Menu 

 
The MARC Format menu (Figure 3-12) is enabled when your database has multiple 
MARC formats available. This menu lists the MARC Formats available for the MARC 
View record. The current MARC format is identified by a bullet to the left side of the 
format name. By clicking an entry in this list, you can choose other MARC formats for 
the current View. 
 

 

Figure 3-12. MARC View Editor - MARC Format Menu 

 

Note: For information on enabling multiple MARC formats in your Virtua database, 
see the Virtua Profiler/Cataloging Parameters User’s Guide. 

 

3.2.2 Available Tabs 
 
Five tabs are available for display on the MARC View Editor window, but not all five 
tabs will be displayed for any one View record. The purpose of the View record 
determines which tabs will be visible: 
 
Primary Display - Defines the display of data from tags, subfields, and fixed fields of 
bibliographic, authority, and patron records in the Virtua client. 
 
General Tabular Display - Defines the columnar display for the list of holdings 
copies, or records, in the Virtua client. 
 
Items Tabular Display - Defines the columnar display for the list of items in the 
Virtua client. 
 
Patron Activity Display - Determines the activity information that appears on patron 
record windows in the Virtua client. 
 
Patron Account Display - Determines the account information that appears on 
patron record windows in the Virtua client. 
 
For information about working with these tabs, see the next section “Configuring 
Views Using the MARC View Editor” in this guide. 
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3.2.3 Command Buttons 
 
The MARC View Editor offers two command buttons: Save and Cancel. 
 
Save button - Saves the View record to the database and is enabled only when the 
Virtua Profiler has an active connection. If you are editing a local View record and 
want to save it to the database, you can do so only if there is an active connection. 
(Otherwise, you can save the record to a local file.) 
 
Cancel button - Cancels your editing session and returns you to the tree of Views on 
the OPAC tab. If you have made changes to a View record and then click Cancel, the 
system will display the following message: 
 
 

 

Figure 3-13. Confirm Message Upon Canceling 

 

3.3 Configuring Views 

 

3.3.1 Overview 
 
After the initial installation of Virtua at your site, your database will include a set of 
default MARC View records. You will need to evaluate these View records and 
customize them to fit your library’s needs. In this section, we outline a typical 
workflow for customizing your View records. 
 

 First, for each Client View, decide on which information you want to display. 
Then, in the appropriate View record, configure the labels, tags, indicators, 
subfields, and columns that will display the information. These View records will 
be used to display bibliographic, holdings, patron, and item information in the 
default language and default format. 
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 Secondly, for each Client View record, you may want to define one or more 
specific Formats that specify the elements that will display if the source record for 
the View meets certain conditions in terms of record Type and/or Bib Level. 
Configurations for Formats must be done on the Primary Display tab.  

 

 Thirdly, if your system is multilingual, you will want to translate the View records 
and any Formats you added to them. You will translate the labels that you defined 
for the tags, indicators, subfields, and columns—that is, any element that you want 
to display in any language other than the default language. 

 

 Finally, after you modify a View, you need to load the modified View record so 
that it appears in the Virtua client. To load new View records in the Virtua client, 
launch (or re-launch) the client and connect to the Virtua server. The client 
automatically retrieves the Views from the database.  

 
In this section of the guide, we discuss in detail how to configure Views by editing the 
elements on different tabs of a MARC View record. We will cover the following 
topics: 
 

 Working with the MARC View Editor List box 

 Editing the Primary Display elements 

 Editing the General Tabular Display elements 

 Editing the Items Tabular Display elements 

 Editing the Patron Activity/Patron Account Display elements 

 Saving MARC View records. 
 

3.3.2 Working with the Common List Box 
 
The tabs of the MARC View Editor use a common list box to handle many of the 
tasks involved in configuring a View record, such as listing tags and column names. 
Below, we display an example of this list box, which happens to be on the Patron 
Activity Display tab (Figure 3-14). 
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Figure 3-14. Sample List Box 

 
Below are instructions for using the list box. In most cases, you can use the list box to 
add, delete, and reorder entries. 
 

3.3.2.1 Adding an Entry to a List Box 

 
To add an entry to a list box, 
 
1. Click the New button. 
 

In the list box, a new line appears with a default value. 
 
2. In the text box (which is labeled Column Name in our Sample List Box above), 

edit the default value as needed. 
 

Tip: After you finish editing a value in the text box, you can press the Enter key or 
click the New button again to create another new line in the list box. 

 

3.3.2.2 Deleting an Entry from a List Box 

 
To delete an entry from a list box, 
 
1. Select the item you want to delete. 
2. Click the Delete button. 
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Unless the “Delete Warnings” message is turned off, the software asks if you are 
sure you want to delete the entry. 

 
3. Click the OK button. 
 
The item is deleted along with any other associated information. 
 

3.3.2.3 Rearranging the Order of Items in the List Box 

 
Unless otherwise stated in this guide, the order of items in a list box represents the 
order in which the items appear in a View in the Virtua client (Figure 3-15). 
 
 

 

 

Figure 3-15. Comparing the Order of the Elements in the Tag Label Information List Box with the Virtua Client 

 
To move an item in a list box, 
 

 Select the item and drag it to a new place in the list. 
-OR- 
Select the item and click the up-one or down-one (pointing hands) button.  
 

When you move an item up to a new position, all items at or below the new place will 
shift down to accommodate the move. Conversely, when you move an item down to a 
new position, all items at or above the new place will shift to accommodate the move. 
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3.3.3 Editing the Primary Display Elements 
 
The Primary Display tab (Figure 3-16) defines the display of “primary” information 
from a source record. By primary information, we mean data that is stored in subfields 
or fixed fields, which are contained in tags within a source record. 
 
 

 

Figure 3-16. MARC View Editor - Primary Display Tab 

 
Each element defined on the Primary Display tab is a fixed field or a subfield coming 
from a tag in a 2709 MARC communications format record. Views configured on the 
Primary Display tab specify which fixed field and/or subfield values from the source 
record are displayed; how the tags, subfields, and fixed fields are labeled; and whether 
the whole tag or its subfields are hyperlinked for searches.  
 
Specifically, for each element that you want to include in a View, you can define: 
 

 The label to display in the View. (Mandatory) 

 Tag numbers, indicators, and occurrences of the tag to display. (Mandatory) 
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 Fixed fields and subfields to display. (Mandatory) 

 Text to display before or after the value of a fixed field or subfield. (Optional) 

 Translations of fixed field/subfield values. (Optional) 

 OPAC search hyperlinks for the field or specified subfields. (Optional) 
 
If you do not define the mandatory parts of an element, the MARC View Editor will 
not let you save the View record. 
 

3.3.3.1 Workflow for Editing Primary Display Elements 

 
The Primary Display tab is subdivided into various areas. Each area deals with a 
specific aspect of any element you add to the View. When adding an element, you need 
to look at each area. We recommend using the following workflow: 
 
1. In the Tag Label Information area add and name the new element. 
 
2. In the Tag Information area, specify for one or more elements in the Tag Label 

Information area, the associated Normal Tag(s). If the element in the Tag label 
Information area cannot be associated with a Normal Tag you assign Leader as the 
tag type instead. 

 
3. If desired, edit the 880 tag display options in the Tag Information area. 
 
4. In the Fixed Field/Subfield Information area, add one or more subfields or fixed 

fields to the tags you assigned in the Tag Information area. If in step 2 you chose 
Leader as the tag type, you can add only fixed fields.  

 
5. If desired, for each fixed field or subfield you defined in the Fixed Field/Subfield 

Information area, define one or more translation values to use when a specified 
value appears in a source bibliographic record. 

 
6. If desired, for one or more elements in the Tag Label Information list box, add 

beginning and ending text in the Punctuation area. Such text will appear before and 
after the specified fixed field or subfield information appearing in a View. 

 
7. If desired, for one or more elements in the Tag Label Information list box, create 

search hyperlinks in the OPAC Search Hyperlinks area. Such hyperlinks will appear 
in the header of the View Record and/or View Holdings Record in the OPAC. 

 
8. Save the changes you made to the MARC View Editor. 
 
Your changes will appear in the Virtua client the next time you start a new connection.  
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3.3.3.2 Editing Tag Labels 

 
The Tag Label Information area (Figure 3-17) on the Primary Display tab is where you 
define the elements of a source record that you want to appear as a line of data in the 
Virtua client. The number of labels that will actually display in a View depends on the 
design of that View and whether a scroll bar is available. For example, the List of Titles 
window in the Virtua client will display only the first four data elements, while the 
header on the Item Information window will display only the first three.   
 
 

 

Figure 3-17. Primary Display Tab - Tag Label Information 

 
The elements in the Tag Label Information list box determine what information 
appears in the View and in what order. 
 
To add an element to the current View, 
 
1. Click the New button. 
 

A new entry (NewTagLabel) appears as the last item in the Tag Label Information 
list box (Figure 3-18). 
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Figure 3-18. Tag Label Information - Adding a Label 

 
2. In the Tag Label text box, type the actual label that you want to appear in the 

View. 
 

Note: A label can be of any length and contain any character. 

 
You now need to specify the tag data that you want to appear along with this labeled 
element. For information about specifying tag data, see the following section. 
 

3.3.3.3 Editing Tag Information for a View Element 

 
For each labeled element specified in the Tag Label Information area, you can assign 
one or more tags. The Tag Information area (Figure 3-19) on the Primary Display tab is 
where you specify the tags.  
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Figure 3-19. Tag Information Area 

 
It may be that the labeled element you are defining is not associated with data in a 
“normal tag.” If this is the case, you can choose Leader as the tag type in the drop-
down list box (Figure 3-20). 
 
 

 

Figure 3-20. Tag Information Drop-down List 

 
If you choose Leader as the “tag type,” you cannot specify tags in the Tag Information 
list box. 
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3.3.3.3.1 Assigning the Leader to a View Element 

 
In the Tag Information area, you can specify that the data for a View element listed in 
the Tag Label Information area comes from the Leader. If you specify this by choosing 
Leader as the tag type, all the other controls in the Tag Information area will be 
disabled. 
 
To assign the Leader to the View element, 
 
1. Select an element in the Tag Label Information list box. 
 

The controls in the Tag Information area are enabled. 
 
2. In the Tag Information drop-down list, select Leader. 
 

All other controls in the Tag Information area are disabled (Figure 3-21). 
 
 

 

Figure 3-21. Tag Information - Leader Selected 

 
To assign specific positions in the Leader to the View element, configure settings in 
the Fixed Field/Subfield Information area. For information on working in the Fixed 
Field/Subfield area, see the section "Editing Fixed Field/Subfield Information." 
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3.3.3.3.2 Specifying Tags for a View Element 

 
You can specify one or more tags as the source for each element in a View. 
Additionally, you can specify the occurrence and indicators of tags that you assign.  
 
To specify a tag for a View element, 
 
1. Select an element in the Tag Label Information list box. 
 

The controls in the Tag Information area are enabled. 
 

2. In the Tag Information drop-down list, select Normal Tag, the default. 
 
3. In the Tag Information area, click the New button. 
 

A new line (100****) appears in the Tag Information list box (Figure 3-22).  
 
 

 

Figure 3-22. Tag Information - Adding a Tag 

 
4. In the Number text box, type the actual three-digit tag number you want to assign 

to this element. 
 
5. In the Indicators text box, type the indicators you want to use as criteria for a tag 

to appear for this element. You can use an asterisk (*) as one of the characters or 
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for both characters to indicate that a specific value for either or both characters is 
not necessary to qualify for the element. 

 

Note:  

 The Indicator(s) field must contain exactly two characters, which can be 
alphanumeric, asterisks, or spaces. 

 Tags with tag numbers less than 010 have no indicators. For these tags, the 
indicator field is disabled. 

 
6. In the Occur text box, specify the two-digit number of the occurrence of the 

specified tag that you want to display. For example, type 02 to specify the second 

occurrence of the tag. 
-OR- 
If you want to display all occurrences, type ** 

 

Warning: Using only ONE asterisk and a number in the Occur edit box could 
cause an error in the Views. 

 
7. Repeat steps 2 - 6 for each additional tag you want to assign to this element. 
 

Note: When multiple tags are specified and if the source record contains any of the 
tags, the tag's data will be labeled and displayed with a duplication of the label. 

 

3.3.3.3.3 Working with the Radio Buttons 

 
Three radio buttons in the Tag Information area let you determine which tag's 
information will display when multiple tags appear in the Tag List. 
 

 If the default radio button Show All Found is selected, then… 

 If multiple tags exist in the Tag List and if the source record contains any of 
these tags, the software will label and display the data in each of the tags using 
the same label. (Even if only one tag appears in the Tag List, but the source 
record contains multiple occurrences of that tag, the software will label and 
display each occurrence using the same label.) 

 If the radio button Show Only the First [1] or [2] or [3] is selected, then… 

 If multiple tags exist in the Tag List and if the source record contains any of 
these tags, the software will label and display the data of only the first tag found 
or only the first two or only the first three tags found, depending on the number 
in the text box. 

 If the radio button Show Only the Last [1] or [2] or [3] is selected, then… 
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 If multiple tags exist in the Tag List and if the source record contains any of 
these tags, the software will label and display the data of only the last tag found 
or only the last two or only the last three tags found, depending on the number in 
the text box. 

 
After working with the Tag Information area, the next step is to assign specific 
subfields in the tag (or specific fixed fields in the Leader) to the View element by 
configuring settings in the Fixed Field/Subfield Information area, which we discuss in 
the next section. 
 

3.3.3.3.4 Working with 880 Tag Display Options 

 
The Tag Information area of the Primary Display tab contains options for the display 
of 880 tags. The options reside in a drop-down list and a check box. 
 
An 880 tag contains the full content in a different script of another field in the same 
record, and it is linked to the associated regular tag by subfield $6. Subfield $6 has the 
following two-part structure:  

 Linking tag - Three-digit tag number of the associated tag. 

 Occurrence number - Two-digit number (right justified with a zero in the unused 
position), which is the same in both the 880 tag and its associated tag. If multiple 
880 tags exist, you can increment this number to allow for the correct linkage. 

 
Example:  880    2#$6110-01 $a Heading in Hebrew script linked to associated field 
 
The 880 Tag Selection drop-down list (Figure 3-23) in the Tag Information area lets 
you specify if and how you want the 880 tag data and/or its associated tag data to 
display in the View. We describe the choices below. 
 

 

 

Figure 3-23. 880 Tag Selection Drop-down List 

 

 Ignore 880 (Default): Tells the software to display the original tag data and ignore 
the linked 880 tag. 
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 Display 880 or original: Tells the software to display the 880 tag data instead of 
the associated tag data. If a linked 880 tag does NOT exist, the software displays 
the original tag data. The 880 tag data will be displayed with the label and in the 
position set for the original tag data. 

 Display original and 880: Tells the software to display both the original tag data 
and the linked 880 tag data.  

 Display 880 and original: Tells the software to display both the linked 880 tag 
data and the original tag data. This option is the same as the previous option except that the 
display order of the tag pair is reversed. 

 
The Display 880$6xxx00 check box (Figure 3-24) tells Virtua how to handle unlinked 
880 tags. Unlinked 880 tags have 00 as the occurrence number.  
 

 

 

Figure 3-24. Display 880$6xxx00 Check Box 

 
If the check box is… 

 Unchecked - Tells the software NOT to display unlinked 880 tag data. 

 Checked - Tells the software to display both 1) data from any unlinked 880 tag, 
using the label that is defined for the original tag and 2) data from the original, 
non-880 tag if it exists in the same record. When data from both tags are displayed, 
the software will display the non-880 tag data first. 

 
Selecting or not selecting the Display 880$6xxx00 check box has NO effect on the 
choice you made in the 880 Tag Selection drop-down list (see above). 
 

3.3.3.4 Editing Fixed Field/Subfield Information 

 
The Fixed Field/Subfield Information area lets you specify the fixed field or subfield 
values to be displayed for each label listed in the Tag Label Information area (Figure 
3-25). If the tag associated with the label has a number less than 10 or is a Leader tag 
type or has the number 999, then only fixed fields are specified. Otherwise, subfields 
are specified.  
 
If you do not specify particular fixed fields or subfields, the software will display ALL 
fixed fields or ALL subfields, as appropriate. 
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Figure 3-25. Fixed Field/Subfield Information Area 

 

Note: In the Virtua client, fixed field and subfield information appears in the order the 
fixed fields/subfields are cataloged in the associated tag. 

 
 
To add a fixed field/subfield, 
 
1. In the Tag Label Information area, highlight the label for which you want to 

specify fixed fields/subfields. 
 
2. In the Fixed Field/Subfield Information area, click the New button. 
 

A new fixed field with default text (%1.1) or subfield with default text (%x*) 
appears below the last item in the Fixed Field/Subfield list (Figure 3-26). 
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Figure 3-26. Fixed Field/Subfield Information Area 

 
3. In the Fixed Field/Subfield text box, edit the fixed field or subfield as needed. 
 
For details on how to specify fixed fields in the Fixed Field/Subfield Information area, 
see the next section “Specifying Fixed Fields.” For details on how to specify subfields 
for variable field tags, see the section “Specifying Subfields.” 
 

3.3.3.4.1 Specifying Fixed Fields 

 
In the Fixed Field/Subfield Information area, you specify a fixed field according to the 
following format: 
 
<leading text>%<start position>.<end position><trailing text>, 
where: 

 <leading text> is a series of characters, which can be punctuation, to display in 
front of the fixed field. 

 % is the % sign on your keyboard; 

 <start position> is the first byte within the fixed field to display (range = 0 to 
9999). 

 <end position> is the last byte within the fixed field to display (range = 0 to 
9999). 

 <trailing text> is a series of characters to display at the end of the fixed field. 
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The default fixed field is %1.1, which means that the fixed field maintains position one 
and contains one letter or number. A fixed field designation of %5.5 means position five 
containing one letter or number, and a designation of %2.5 means position two containing four 
letters or numbers (See the Virtua Cataloging Reference Guide for the position and number of 
letters/numbers associated with a given fixed field). The fixed field specifications can 
be of any length. 
 

Note: Information in the Fixed Field/Subfield list box appears in the Virtua client in 
the order the fixed fields/subfields are cataloged in the associated tag. 

 
To create a new line after the display of fixed field text: 
 

 Add \n to the end of the <trailing text>. 
 
Otherwise, the fixed field space is delimited and line wrapped. 
 

3.3.3.4.1.1 Specifying 006 or 007 Fixed Field Data 

 
If the fixed field value to display is associated with tag 006 or tag 007, you need to 
enter data in a way that includes the special type character, which is the first character 
of the 006 and 007 fields.  
 
In the Fixed Field/Subfield Information area, you must… 

 Place the special character in front of the <leading text> for each fixed field listed 
in the Fixed Field/Subfield List. 

 Specify ALL the fixed fields for ALL the special types that you want to display in 
the View. 

 
For example, if you want the fixed field data in tag 006 to display in a View, the Fixed 
Field/Subfield List should look something like the following list. (Note the special 
character that is placed before each fixed field and the inclusion of each fixed field 
associated with each special type character.)  
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aBOOK Illus: %1.4 
aAudience: %5.5 
aForm: %6.6 
aContents: %7.10 
aGov Pub: %11.11 
aConf Pub: %12.12 
aFestschrift: %13.13 
aIndex: %14.14 
aFiction: %16.16 
aBiography: %17.17 
mCOMPUTER FILE Audience: %5.5 
mFile: %9.9 
mGovt Pub: %11.11 
pMIXED MATERIAL Form: %6.6 
etc. 

 
As an example, the View Bibliographic Record: Full Display View record (Figure 3-27) 
shows the start of such a list of 006 fixed fields in the Fixed Field/Subfield 
Information area. 
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Figure 3-27. MARC View Editor - Example of Fixed Field List 

 
When the 006 tag data from the source record are displayed, only those fixed fields in 
the View record that start with the character found in the first byte of the 006 tag data 
will be displayed. That is, if the first character of the source record’s 006 tag data is 
“m,” only the fixed fields in the View record starting with “m” are displayed. 
 

3.3.3.4.1.2 Displaying Special Type Characters 

 
The special type character, which you must include to specify the data of the 006 and 
007 fixed fields, is NOT displayed in the View in the client. If you want the special 
type character to display, you need to include it as the first character in the <leading 
text> portion of the format used in the Fixed Field/Subfield Information area.  
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To display, say, the special type character “m” in the View for the following 006 
fixed field data: mCOMPUTER FILE Audience: %5.5 
 

 Type the “m” again as the first character of the <leading text>. For example: 
 mm = COMPUTER FILE Audience: %5.5 

 
As a result, the View in the client will display this: 
m=COMPUTER FILE Audience: [value] 
 

3.3.3.4.2 Specifying Subfields 

 
In the Fixed Field/Subfield Information area, you specify a subfield according to the 
following format: 
 
<leading text>%<subfield character><subfield occurrence><trailing text>, 
where: 

 <leading text> is a series of characters, which can be punctuation, to display in 
front of the fixed field. 

 % is the % sign on your keyboard. 

 <subfield character> is a or b or any single, alphanumeric digit. 

 <subfield occurrence> is a number greater than 0 or an asterisk (*), which implies 
that all subfield occurrences qualify. 

 <trailing text> is a series of characters, which can be punctuation, to display at the 
end of the fixed field. 

 
The default subfield is %x*. The subfield specifications can be of any length. 
 

Note: Information in the Fixed Field/Subfield list box appears in the Virtua in the 
order that the fixed fields/subfields are cataloged in the associated tag. 

 
To create a new line after the display of subfield text: 
 

 For display in the Virtua client, add \n to the end of the <trailing text>. 
 
Otherwise, the subfield space is delimited and line wrapped. 
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3.3.3.5 Editing Punctuation: Beginning/Ending Text 

 
In the Punctuation area two edit fields let you add or modify text that surrounds the 
fixed field/subfield values that are displayed for a selected tag label. The two fields are 
Beginning Text and Ending Text. 
 
The Beginning Text value and Ending Text value can be a series of any characters of 
any length. In our example below, the beginning text is an open bracket and the ending 
text is a closed bracket. 
 

Example 
Beginning Text:  [ 
1st Subfield Spec: %a* -  
2nd Subfield Spec: %b1 
3rd Subfield Spec: , %b* 
Ending Text: ] 

 
Let’s say that you specify the above elements in a View. Let’s also say that the source 
record tag has a subfield $a value of Red, a subfield $b value of Blue, another subfield 
$b value of Yellow, and yet another subfield $b value of Green. Then this View would 
dictate the following OPAC display: [Red - Blue, Yellow, Green] 
 

3.3.3.5.1 Adding/Modifying Beginning and Ending Text 

 
To add or modify Beginning Text and Ending Text, 
 
1. In the Tag Label Information list box, highlight the tag to which you want to add 

beginning and ending text. 
2. Find the Punctuation area located below the Tag Information area. 
3. In the Beginning Text field, add or edit the text that you want to appear at the 

beginning of the group of fixed fields or subfields displayed for that tag. 
4. In the Ending Text field, add or edit the text that you want to appear at the end of 

the group of fixed fields or subfields displayed for that tag.  
 

Note: The text in either field can be a series of characters of any type and length. 

 



 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

Virtua Profiler/OPAC Parameters (v. 16.1)  89 

3.3.3.6 Editing the Value Translation Information Area 

 
To activate the Value Translation area on the Primary Display tab, you must first select 
an item in the Fixed Field/Subfield Information list. The value translation feature lets 
you specify field values and their translations so that when the software is to display a 
fixed field or subfield value, it displays the translation instead. 
 
The value translation feature is especially useful with regard to fixed fields, which often 
use abbreviated forms as values. For each code in a fixed field, you can define a text 
string to display in the View. 
 
To add a field value translation, 
 
1. In the Fixed Field/Subfield Information list, highlight the element whose value 

you want to translate. 
 

The Value Translation Information area becomes active. 
 

2. In the Value Translation Information area, click the New button. 
 

A default value appears in the Value field, and the words New Translation appear in 
the Translation field (Figure 3-28). 

 
 

 

Figure 3-28. Value Translation Information Area 
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3. In the Value text box, type the actual fixed field or subfield value to which you 
want this translation to apply. 

Note: If the field value ends with a trailing space character (such as ‘fr  ’), omit the 
trailing space when you enter it in the Value text box. 

 
4. In the Translation text box, type the text that you want to appear when the 

specified value is in the selected tag. 
 

The new field value and its translation appear in the Value Translation Information 
list. 
 

3.3.3.7 Creating OPAC Search Hyperlinks 

 
You can create search links for data returned in a client View by enabling the OPAC 
Search Hyperlinks area of the MARC View Editor.  
 
Information displayed in a client View with OPAC search hyperlinks enabled allows 
you to perform a pre-defined search on the hyperlinked View information. Hyperlinks 
that you define can appear in the client on all tabs of the View Bibliographic Record 
window and on the Full and Items tabs of the View Holdings Record window. 
 
To create an OPAC Search Hyperlink for a tag, 
 
1. In the Tag Label Information list box, click the desired tag label for the search 

hyperlink. 
 
The tag associated with the tag label appears in the Tag Information list box. 
 

2. Click the Show as Search Link check box in the Tag Label Information area. 
 

The fields in the OPAC Search Hyperlinks area of the MARC View Editor become 
active (Figure 3-29). In addition, the check box next to any subfield or fixed field in 
the Fixed Field/Subfield Information list box becomes selectable.  
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Figure 3-29. MARC View Editor - OPAC Search Hyperlinks Enabled 

 
In the Fixed Field/Subfield Information list box, by selecting or de-selecting a 
subfield, you can determine which subfield data will be used in the hyperlinked 
search. 
 

3. In the Fixed Field/Subfield Information list box, select the desired subfields. 
-OR- 
Select ALL the subfields. Virtua will use the data in the entire tag in the new 
search.  

 
4. In the Non-filing Indicator area, select:  

 None, if you want NO characters ignored in your search. 

 First Indicator, if you want to use the first indicator of a tag to determine how 
many characters to ignore in your search. 

 Second Indicator, if you want to use the second indicator of a tag to 
determine how many characters to ignore in your search. 

 
5. In the Search Type drop-down list, select the type of search that Virtua should 

perform on the tag/subfield data.  
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Note: If more than one subfield is selected, Virtua will perform the same type of 
search on ALL of them. If you want Virtua to perform a different type of search 
for each subfield, you must configure a separate tag label for that tag/subfield 
combination. 

 
6. In the Linking Entry Fields MARC Code area, specify the MARC code, using no 

parentheses, for any linking field (001, 760-789) that has been designated as a 
search hyperlink. The Linking Entry Fields MARC Code area is enabled under two 
circumstances only: 1) The 001 tag has been designated to do a CN: Control 
Number Link search for a component part analytic record and 2) Any of the 
linking fields 760-789 has been designated to do a control number search, such as a 
Bib-ID search. If the control number in the subfield $w of any tag 760-789 is 
preceded by the specified MARC code, the field will be displayed as a hyperlink in 
the record.  

 

Note: This MARC code is optional for displaying search hyperlinks for tags 760-789 
subfield $w in the Virtua client. Even if no MARC code is defined, the subfield $w 
of 760-789 tags will appear as search hyperlinks if they are otherwise qualified to 
do so. 

 
7. If desired, click the Show Search Links By Subfield check box. 

 

Note: The “Show Search Links By Subfield” check box controls whether 
individual search links are displayed for each of the subfields in a source record tag.   

 If the box is checked, the OPAC display will show a separate search hyperlink 
for each specified subfield found in the source record tag. Clicking the 
hyperlink will initiate a search using the data from the individual subfield.   

 If the box is unchecked, the OPAC display will show a single hyperlink that is 
generated for a combination of the specified subfields. Clicking the hyperlink 
will initiate a search using the data from the combined subfields. 

 
The search link is now configured for the selected tag.  
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Hints:  Some useful search hyperlinks that you may want to configure: 

 Tag 856, subfield $u, is used to store the URL needed to locate and access an 
electronic resource. If configured in a view, tag 856 will always be displayed as a 
search hyperlink as long as the tag contains the subfield $u with a link to an 
electronic resource. 

 If configured in a view, bibliographic tags 505, 514, 520, 530, 545, 552, 555, and 
583 will always be displayed as search hyperlinks as long as the tags contain the 
subfield $u with a link to an electronic resource. 

 If configured in a view, authority tags 670 and 678 will always be displayed as 
search hyperlinks as long as the tags contain the subfield $u with a link to an 
electronic resource. 

 Tag 856, subfield $y, is used for display in place of the URL. When subfield $y is 
present, Virtua will use the contents of it as the link instead of subfield $u linking 
to the URL.  

 Tag 004 of a FRBR Manifestation can be configured to do a Bib-ID search for the 
parent record (for details, see the Virtua FRBR Cataloging User’s Guide). 

 Tag 001 or tag 035 of a parent analytic record can be configured to do a CN: 
Control Number Link search for tag 773 subfield $w of the component part 
record. Tag 773 subfield $w of a component part (child) record can be configured 
to do a CN: Bib-ID search for tag 001 or a CN: Local Number search for tag 035 
of the parent analytic record (for details, see the Virtua Cataloging User’s Guide). 
(Note that in CATMARC databases, only tag 035 of a parent analytic record can be 
assigned as the 773 subfield $w control number.) 

 For bibliographic 6xx tags, you can create search hyperlinks using user-defined 
subject thesauri as search types, which are labeled in the Search Type list as 
"BR: Subject - User defined 1" - "BR: Subject - User defined 10." 

 You can create search hyperlinks to view authority records using the “AU: Author” 
and/or “AU: Subject” elements in the Search Type list. In the client, if the search 
term is under author/subject authority control, clicking the hyperlink will open the 
View Authority window. If the search term is not under authority control, a 
message will appear: "Sorry, that heading does not appear to be under authority 
control."  

 UNIMARC databases only: If configured in a view, UNIMARC tags 036, 316, 317, 
318, 320, 321, 327, 334, 335, 337, 345 and 488 will always be displayed as a search 
hyperlink as long as the tag contains the subfield $u with a link to the URI of an 
electronic resource. 
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3.3.4 Editing the General Tabular Display Elements 
 
The General Tabular Display tab (Figure 3-30) lets you determine the display of data in 
the Virtua client that comes from a series of source MARC records. The General 
Tabular Display tab is used to determine the display of the list of holdings copies, or 
records, on the View Bibliographic Record window/Holdings tab in the client, which 
uses the View Bib Record: Holdings Header/Item Details View record. 
 
 

 

Figure 3-30. General Tabular Display Tab 

 
In the Column Information list on the General Tabular Display tab, each label, such as 
Location, corresponds to a column that appears in the list box on the Holdings tab of 
the View Bibliographic Record window in the Virtua client (Figure 3-31).  
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Figure 3-31. View Bibliographic Record Window - Holdings Tab 

 

3.3.4.1 Working with Elements of the General Tabular Display 

 
Procedures for adding, deleting, and modifying elements on the General Tabular 
Display tab are similar to those for the Primary Tabular Display tab. You can use the 
instructions in the section “Editing the Primary Display Elements” to work with 
options on the General Tabular Display tab.  
 
There are important differences between the Primary Display tab and the General 
Tabular Display tab. For starters, the following options on the Primary Display tab are 
NOT available on the General Tabular Display tab: 

 OPAC Search Hyperlinks  

 Punctuation: Beginning Text and Ending Text 
 
In addition, the following differences exist: 
 

 Column Labels - The Tag Label Information area on the Primary Display tab 
becomes the Column Information area on the General Tabular Display tab. If a 
source tag for a column label occurs multiple times in a source record, the tag data 
appears in multiple lines within the same row. The order of the labels in the list 
determines the order of the columns in the table. 

 All Data for All Occurrences - On the General Tabular Display tab, you cannot 
select the tag occurrence in the Tag Information area. The software displays ALL 
occurrences of all data in the source record. 
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 Column Width Information - On the General Tabular Display tab, you can 
specify the width of each column you define for the table. To do this, for each 
element in the Column Information list, define in the Column Width Information 
field (Figure 3-32) the percent of the holdings list box that the column will use. 

 

 

Figure 3-32. Column Width Information Field 

 
The total percentage of the widths for all the elements in the Column Information 
list is computed and maintained by the MARC View Editor. The total, which is 
recomputed every time the width of an individual column changes, must equal 100 
at save time.  

 

3.3.5 Editing the Items Tabular Display Elements 
 
The Items Tabular Display tab on the View Record/View Holdings Record: Items 
Header/Items Display View record (Figure 3-33) lets you determine the display of item 
data in the Virtua client. This same interface is used on the Patron Check Out/Renew 
Display View Record and the Patron Check In Display View Record. 
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Figure 3-33. MARC View Editor - Items Tabular Display Tab 

 
Each label in the Column List corresponds to a column that appears in the items list 
box on the Items tab (Figure 3-34) of the View Bibliographic Record window or View 
Holdings Record window in the client. 
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Figure 3-34. Virtua Client - Items Tab of the View Bibliographic Record Window 

 
For each element that you want to appear as a column in an item list, you need to 
configure: 
 

 The label of the column. 

 The information that appears in the column. 

 The amount of space allocated to column. 
 
To add an element to an item View, 
 
1. On the Items Tabular Display, click the New button. 
 

A new line (NewColumn) appears in the Column List (Figure 3-35). 
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Figure 3-35. Items Tabular Display 

 
2. In the Column Name text box, type the actual label that you want to use for the 

column. 
 
3. In the Item Field Source of Column Data drop-down list , choose the data that 

you want to appear in this column (Figure 3-36). 
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Figure 3-36. Items Tabular Display - Adding a New Column 

 
4. In the Column Width as % of Table field, type the percentage of the display that 

you want this column to occupy by default. The Column Width Total, which is 
recomputed every time the width of an individual column changes, must equal 100 
at save time.  

 
5. Save your changes. 
 

3.3.6 Editing the Patron Activity Display Elements 
 
The Patron Activity Display tab lets you determine the display of information in the 
Virtua client about specific types of patron activity such as items checked out, items 
pending, or booked items. The Patron Activity Display tab appears on each of the ten 
Patron Activity View records. Each Patron Activity View record encodes the View for 
a specific patron activity. For example, Figure 3-37 shows the Patron Activity: Checked 
Out View record. 
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Figure 3-37. MARC View Editor - Patron Activity Display Tab 

 
Each label in the Column List on the Patron Activity Display tab (Figure 3-37) 
determines a column name that will be displayed on the Patron Activity tab/Checked 
Out page tab in the client (Figure 3-38).  
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Figure 3-38. Patron Activity Tab - Checked Out Page Tab 

 
For each label that you want to appear as a column in the View, you need to configure: 
 

 The label of the column. 

 The information that appears in the column. 

 The amount of space allocated to column. 
 
To add an element to a patron View, 
 
1. On the Patron Activity Display tab, click the New button. 
 

A new line (NewColumn) appears in the Column List (Figure 3-39). 
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Figure 3-39. Patron Activity Display 

 
2. In the Column Name text box, type the actual label that you want to use for the 

column. 
 

3. In the Patron Activity Field Source of Column Data drop-down list, choose the 
data that you want to appear in this column. 

 
4. In the Column Width as % of Table field, type the percentage of the display that 

you want this column to occupy by default. The Column Width Total, which is 
recomputed every time the width of an individual column changes, must equal 100 
at save time. 

 

3.3.7 Editing the Patron Account Display Elements 
 
The Patron Account Display tab (Figure 3-40) lets you determine the display of patron 
account information for various types of account activity in the Virtua client. The 
Patron Account Display tab appears on the Patron Account View record, only one of 
which exists for the client. 
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Figure 3-40. MARC View Editor - Patron Account Display Tab 

 
The procedure for configuring the elements on the Patron Account Display tab is the 
same as for configuring the elements on the Patron Activity Display tab.  
 
Each label in the Column List on the Patron Account Display tab corresponds to a 
column that appears in the client on the Patron Information window/Patron Account 
tab (Figure 3-41). The View encoded by the Patron Account View record is used by 
each type of account activity that is defined in the system. 
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Figure 3-41. Patron Information Window - Account Tab 

 

3.3.8 Saving Your Changes and Quitting the Editor 
 
To save changes you made to a View record in the MARC View Editor, 
 

 Press the CTRL+S keys. 
-OR- 
Click the File menu and then choose Save. 

 

Note: If you enter invalid data in a field, the software will not let you save. 

 
To quit the MARC View Editor, 
 
1. Press the ALT+X keys. 

-OR- 
Click the X button in the upper right corner of the window. 
-OR- 
Click the File menu and then choose Exit. 
 
If there are unsaved changes, the software asks if you want to save your changes to 
the record. 
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2. Click the Yes button to save, the No button to quit without saving, or the Cancel 

button to return to the View Editor. 
 

3.4 Working with Formats 

 
Each MARC View record has a default Format. The configuration of the default 
Format specifies NO conditions that a source record must meet in terms of a 
qualifying record Type or Bib Level. But the MARC View Editor lets you add to a 
View other Format configurations that do have specified conditions. A Format 
indicates the View configuration that the software should use when a source record 
meets specified conditions in terms of qualifying record Type and/or Bib Level.  
 
If two or more Formats exist for a View record, this is how Virtua will handle the 
View in the client: 

 It will use the first qualifying Format that is configured for both Bib Level and 
Type. 

 If there is no such qualifying Format, it will use the first Format that is configured 
for Bib Level. 

 If there is no such qualifying Format, it will use the first Format that is configured 
for Type. 

 If it finds no such qualifying Format, it will use the default Format (which is blank 
for both Bib level and Type). 

 
To add a Format configuration to a View record, you start by 
 
-launching the View record, 
-adding the name of the Format to the Edit Format List,  
-selecting the name on the Format menu, and then 
-configuring the View for the Format. 
 
For each Format that you add, you can configure all the elements separately, meaning 
that Views do not need to share elements. Note that Views by Format can be 
configured on the Primary Display tab only. 
 
Additionally, you can create one or more translations for each Format (see the section 
"Working with Languages and Translations"). 
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Note:  

 There are two View records that use the Format function a little differently than 
other View records: 1) View Holdings Record: Full Display View and 2) Serials 
Check-in View. In the client, the header of both the View Holdings Record/Full 
tab and the Serials Check-in window can display information from both the 
bibliographic record and the holdings record. They can do this if—on each View 
record—you configure the bibliographic data elements in the default Format and 
configure the holdings data elements in a Holdings Format that you add to the 
View record. 

 For information on how to configure MARC holdings information for display on 
the View Bibliographic Record window/Holdings tab, see the description of the 
View Bib Record: Holdings Header/Item Details View Record. 

 

3.4.1 Displaying the Edit Formats Window 
 
To display the Edit Formats window, 
 
1. Click the Edit menu of the MARC View Editor. 

 
2. Choose Edit Format List. 
 
The Edit Formats window appears, listing the available Formats, if any, for the current 
MARC View record (Figure 3-42).  
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Figure 3-42. Edit Formats Window 

 

3.4.2 Aspects of the Edit Formats Window 
 
The Edit Formats window contains the following fields: 
 

 Format List - Lists the current Formats. 

 Format Name - Displays the name of the Format selected in the Format List 
field. 

 Format Types - Displays the code of the record Types to which the currently 
selected Format applies. You can specify more than one Type by separating each 
code with a comma. 

 Format Bib Levels - Displays the code of the Bib Levels to which the currently 
selected Format applies. You can specify more than one Bib Level by separating 
each code with a comma. 

 
From the Edit Formats window, you can… 
 

 Add a new Format, specify its name, and configure its qualifying conditions. 

 Delete an existing Format. 

 Modify an existing Format. 
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3.4.3 Adding a New Format to the Format Menu 
 
To add a new Format to the Format Menu, 
 
1. On the Edit Formats window, click the New button. 
  

A new line (NewFormat) appears in the Format List (Figure 3-43). 
 
 

 

Figure 3-43. Edit Formats Window - Adding a Format 

 
2. In the Format Name field, type the actual name of the Format. 

 
3. In the Format Types field, specify the Type code(s) applicable to this Format. 

 
4. In the Format Bib Levels field, specify the Bib Level code(s) applicable to this 

Format. 
 

5. When you finish configuring settings for the Format, close the Edit Formats 
window by clicking the X button in the upper-right hand corner of the window. 

 The software will check for any duplicate Format names and display an error 
message if it finds a duplicate. 

 The software will add the format to the Format menu. 
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The new Format is now added to the Format menu of the MARC View Editor. 
Initially, the View for this Format will include the same elements as the default Format. 
You need to edit these elements. 
 

3.4.4 Adding a Format Configuration to a View Record 
 
When you add a Format configuration to a View record, the software automatically 
adds a set of default data to the View for the Format. This data duplicates the data in 
the default Format, which is always available and not affected by the Edit Format 
function. To create a customized View for the Format, you need to edit the data. 
 
To add a Format configuration to a View record, 
 
1. Display the View record to which you want to add a Format. 
 
2. Click the Format menu and select the Format you want to add (Figure 3-44). 
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Figure 3-44. MARC View Editor - Format View 

 
 
The MARC View Editor automatically populates the View for the Format with the 
same set of elements as the View for the default Format. 
 
3. Edit the elements as needed to create the View you want for the Format. 
 
4. Save your changes. 
 

3.4.5 Modifying a Format 
 
To modify an existing Format, 
 
1. On the Edit Formats window, select the Format in the Format List that you want 

to modify (Figure 3-45). 
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Figure 3-45. Edit Formats Window - Modifying a Format 

 
2. Edit the Format Name, Format Types, and Format Bib Levels as needed. 
 
3. When you finish modifying the settings for the format, close the Edit Formats 

window by clicking the X button in the upper-right hand corner of the window. 
 

3.4.6 Modifying a Format Configuration 
 
To modify a Format configuration, 
 
1. Display the View record for which you want to modify a Format. 
2. Click the Format menu and select the Format whose configuration you want to 

modify. 
3. Edit the elements in the View. 
4. Save your changes. 
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3.4.7 Deleting a Format 
 
To delete an existing Format, 
 
1. On the Edit Formats window, select the Format in the Format List that you want 

to delete (Figure 3-46). 
 
 

 

Figure 3-46. Edit Formats Window - Deleting a Format 

 
2. Click the Delete button. 
 

Unless you unchecked the Delete Warnings option on the Options menu, a 
warning message appears (Figure 3-47). 

 
 

 

Figure 3-47. Edit Formats Window - Delete Confirmation Message 
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3. Click the OK button to continue with the deletion. 

-OR- 
Click the Cancel button to cancel the deletion. 
 

4. When you finish deleting the Format, close the Edit Formats window by clicking 
the X button in the upper-right hand corner of the window. 

 

Note: When you delete a Format, you delete all the View data you configured for this 
Format. 

 

3.5 Working with Languages and 

Translations 

 
To create Views in different languages, you must use the MARC View Editor to 
translate the View records. The Editor lets you translate the label for each element that 
you define in a View record (or in a Format added to a View record).  
 
The translated View used by the Virtua client depends on the language in which the 
client is operating. If the View record includes a translation for the current language, 
the Virtua client uses that translation. If the View record does not include such a 
translation, the default translation is used. 
 

Note: Each View can have a unique translation. This means that the translation of 
labels in one View do not have to correspond to the translation of labels in another, 
even for identical elements. 

 
To add a translation to a View record or to a Format configuration, start by adding the 
name of the language to the Edit Language List. Then, after opening the View record 
and optionally displaying the Format of your choice, select the desired language on the 
Language menu.  
 

Important: The name of the Language that you add to the Edit Language List must 
match exactly (including upper and lower case letters) the name of the language 
specified in the Virtua client. If it does not match, Virtua will not be able to find or use 
the translated View. 

 
When you select the Language in which to translate a View, the software automatically 
adds to the View or Format configuration a set of View elements to be translated. 
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These elements are duplicates of those found in the default Language, which is always 
available and not affected by the Edit Languages function. 
 

Note: If you create a new language, Virtua will copy the tag numbers and table labels 
from the default language to the new language, but it will NOT copy the subfields, 
which all appear as \x. The software will not copy beginning and ending punctuation 
either. 

 

3.5.1 Displaying and Using the Edit Languages Window 
 
To display the Edit Languages window, 
 
1. Click the Edit menu. 

 
2. Choose Edit Language List. 
 

The Edit Languages window appears (Figure 3-48), listing all the translations 
available for the current MARC View record. Our example shows no translations 
are available. 
 
 



Virtua Profiler/OPAC Parameters (v. 16.1)  

 PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

116 

 

Figure 3-48. Edit Languages Window 

 
The Edit Language List contains the following fields: 
 

 Language List - Lists the current languages. 

 Language Name - Displays the name of the language selected in the Language List 
field. 

 
From the Edit Languages window, you can: 
 

 Add a new language. 

 Delete an existing language. 

 Rename an existing language. 
 

3.5.1.1 Adding a New Language 

 
To add a new Language to the Language menu, 
 
1. On the Edit Languages window, click the New button. 
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A new line NewLanguage appears in the Language List (Figure 3-49). 
 
 

 

Figure 3-49. Edit Languages Window - Adding a Language 

 
2. In the Language Name field, type the actual name of the new Language. 

Note: If the translation is to be for a client View, the Language Name must match 
exactly the language name used in the client. 

 
3. When you finish adding a Language, close the Edit Languages window by clicking 

the X button in the upper-right hand corner of the window. 
 
The new Language is now added to the Language menu of the MARC View Editor. 
Initially, the View for this Language will include the same elements as the default 
Language. You need to translate these elements. 
 



Virtua Profiler/OPAC Parameters (v. 16.1)  

 PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

118 

3.5.1.2 Renaming a Language 

 
To rename a Language in the Edit Language List, 
 
1. On the Edit Languages window, select the Language you want to rename (Figure 

3-50). 
 
 

 

Figure 3-50. Edit Languages Window - Renaming a Language 

 
2. In the Language Name field, type the new name. (The name of the Language must 

match exactly the name in the list of languages in the Virtua client. 
 
3. When you finish renaming the Language, close the Edit Languages window by 

clicking the X button in the upper-right hand corner of the window. 
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3.5.1.3 Deleting a Language 

 
To delete a Language from the Edit Language List, 
 
1. On the Edit Languages window, select the Language you want to delete (Figure 

3-51). 
 
 

 

Figure 3-51. Edit Languages Window - Deleting a Language 

 
2. Click the Delete button. 
 

Unless you unchecked the Delete Warnings option on the Options menu, a 
warning message appears (Figure 3-52). 
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Figure 3-52. Edit Languages Window - Delete Confirmation Message 

 
3. Click the OK button to continue with the deletion. 

-OR- 
Click the Cancel button to cancel the deletion. 
 

4. When you finish deleting Format Views, close the Edit Formats window by 
clicking the X button in the upper-right hand corner of the window. 
 

Note: When you delete a Language, you delete all translated strings in the View record 
for that language, which means all tag labels and column labels. 

 

3.5.2 Translating View Elements 
 
Once you add a Language to the Edit Language List, you can start to translate the 
labels in the View record into that language. 
 
To translate the labels in a View record, 
 
1. Open the View record that you want to translate. 
2. Accept the default Format configuration or select another. 
3. In the menu bar, click Language, and then click the Language you want to work in. 
 
The MARC View Editor automatically populates the View for the Language (Figure 
3-53) with the same set of elements as the View for the default Language. The 
elements are ready to be translated. 
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Figure 3-53. MARC View Editor - Translating a View 

 
4. Select each tag label in turn and translate it in the Tag Label editing field. 
 
5. Add a new tag label as needed. The default NewTagLabel will appear in the Tag 

Label Information list (Figure 3-54). 
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Figure 3-54. MARC View Editor - Translating a View 

 
6. Edit NewTagLabel so that the actual translated label is added to the list. 
 
7. Save your changes. 

 

Note: Currently, when you add a new translated tag label to a Language configuration, 
the software will behave as follows: It will add NewTagLabel in the Tag Label list of 
ALL other existing Language configurations, including the default one. However, if 
you add a new tag label to the default Language configuration, the software will 1) add 
NewTagLabel in the Tag Label list of all other existing Language configurations 2) add 
the actual tag label in any new Language configuration you create. 

 



 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

Virtua Profiler/OPAC Parameters (v. 16.1)  123 

To verify that the labels you translated appear in the Virtua client as desired, do 
the following: 
 
1. Launch the client. 
2. Select for the interface language the language of the translated View elements. 
3. Access the window or screen that uses the translated View. 
4. Verify that the View elements appear as desired. 
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4. Working with the OPAC Basic 

Options Parameter 

 
The OPAC Basic Options parameter contains a number of settings that help you 
customize the OPAC searches in your system.  
 

Important: When you make changes in the OPAC Basic Options, you will need to 
restart the parent psdriver.exe program in order for those changes to take effect in the 
client. 

 
To set basic options for OPAC searches, 
 

 In the “tree” on the OPAC tab, double-click OPAC Basic Options. 
 
The OPAC Basic Options window appears (Figure 4-1). 
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Figure 4-1. OPAC Basic Options Window 
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The following sections provide information on each setting on the OPAC Basic 
Options window. 
 

 Enabling Statistics Gathering 

 Applying Mandatory Filters for Hidden Locations 

 Requiring a Location Filter for Call Number Browse 

 Enabling Non-normalized Keyword Indexing 

 Disabling the Request Button for Serial Bibs 

 Displaying the ZIP Code Before the City… 

 Sorting the Holdings List by Location Name 

 Sorting Patrons by Name, Birthdate, and Barcode 

 Removing Apostrophes from Patron Name Browse Searches 

 Setting Maximum Size of Result Sets for Holdings/Patron Keyword Searches 

 Specifying the Number of Lines per Record in the List of Titles 

 Configuring URL Settings for Enhanced Searching 

 Configuring the URL Setting for Open Skies 

 Setting Default Item Sorting 

 Setting Default Result Set Sorting 

 Setting the Maximum Size of Result Sets for Keyword Searches 

 Linking Virtua with a VITAL Instance 

 

4.1 Enabling Statistics Gathering 

 
The Virtua Profiler gives you an easy way to determine whether you want to gather 
statistics on OPAC activity. On the OPAC Basic Options window (Figure 4-2), you 
have the option to gather statistics about OPAC searches. 
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Figure 4-2. OPAC Basic Options Window - Gather Statistics 
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When the Gather OPAC Statistics check box is selected, Virtua stores data on the 
number and types of OPAC searches in the operation log. 
 

4.2 Applying Mandatory Filters for 

Hidden Locations 

 
The Apply Mandatory Filters for Hidden Locations check box on the OPAC Basic 
Options window (Figure 4-3) is associated with the Hide Holdings/Items setting 
available for a given location (see the Location Names parameter in the Virtua 
Profiler/Global Settings User’s Guide). 
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Figure 4-3. OPAC Basic Options Window - Apply Filters for Hidden Locations 
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When the Apply Mandatory Filters for Hidden Locations check box is selected, the 
holdings and items belonging to any location that is flagged with the Hide 
Holdings/Items setting are hidden from non-authenticated users. 
 

Notes:  

 If you have a consortium database, the Apply Mandatory Filters for Hidden 
Locations check box will also apply to the Hide Holdings/Items settings in the 
Institutions parameter on the Global Settings tab. 

 If you have FRBR or linked bibliographic records in your database, you should not 
enable the Apply Mandatory Filters for Hidden Locations option or its associated 
Hide Holdings/Items option. Instead, you should use item masking to hide 
records in a FRBR or linked bibliographic record database. For more information, 
see the Virtua Cataloging User’s Guide. 

 

4.3 Requiring a Location Filter for Call 

Number Browse 

 
The Require Location Filter for Call Number Browse check box on the OPAC Basic 
Options window (Figure 4-4) lets you determine whether users doing a browse search 
on a call number are required to choose a location filter for their search. In this way, 
users can be made to search for call numbers at a specific location only. 
 
 



 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

Virtua Profiler/OPAC Parameters (v. 16.1)  131 

 

Figure 4-4. OPAC Basic Options Window - Require Location Filter 
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When the Require Location Filter for Call Number Browse check box is selected, users 
will be required to choose a location filter before proceeding with a call number 
browse search. 
 

4.4 Enabling Non-normalized Keyword 

Indexing 

 
By default, Virtua normalizes the data that is indexed for keyword searching and that is 
stored in the database by removing any accent marks or other diacritics in the words. 
To specify that Virtua also store non-normalized keyword indexed data, select the Use 
Non-normalized Keyword Indexing check box (Figure 4-5). 
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Figure 4-5. OPAC Basic Options Window - Use Non-normalized Keyword Indexing 
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 When the Use Non-normalized Keyword Indexing check box is selected, Virtua 
stores non-normalized keyword-indexed data. 

 When the Use Non-normalized Keyword Indexing check box is NOT selected, 
Virtua stores only normalized keyword-indexed data. 

 
Enabling the storage of non-normalized keyword indexed data allows you to perform 
keyword searches in the client on search terms that contain diacritics. For details, see 
the OPAC Workflow-based Reference Guide. 
 

4.5 Disabling the Request Button for 

Serial Bibs 

 
The Disable Request Button for Serial Bibs check box on the OPAC Basic Options 
window (Figure 4-6) lets you determine whether the Request Bib button appears on the 
View Bibliographic Record window for a serial bibliographic record. 
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Figure 4-6. OPAC Basic Options Window - Request Button for Serial Bibliographic Records 
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When the Disable Request Button for Serial Bibs check box is selected, Virtua will 
hide the Request Bib button on the View Bibliographic Record window for a serial 
bibliographic record. Because the Request Bib button is hidden, you will be required to 
make a request from the Items tab instead. The item-level request will give you the 
ability to choose an item at the volume level. 
 

4.6 Displaying the ZIP Code before the 

City in the Patron Address 

 
The Display ZIP Code before City in Patron Address check box on the OPAC Basic 
Options window (Figure 4-7) lets you determine where the ZIP code is displayed in the 
patron address when it appears on the Browse window after a patron name search. 
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Figure 4-7. OPAC Basic Options Window - Zip and City Display 
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When the Display ZIP Code before City in Patron Address check box is selected, 
Virtua will display the ZIP code before the name of the city in the patron address in 
the browse results of a patron name search. 
 
When the Display ZIP Code before City in Patron Address check box is NOT 
selected, the ZIP code appears at the end of the patron address. 
 

4.7 Sorting the Holdings List by 

Location Name 

 
The Sort Holdings List by Location Name check box on the OPAC Basic Options 
window (Figure 4-8) lets you determine how the list of holdings on the Holdings tab of 
the View Bibliographic Record window will be sorted.  
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Figure 4-8. OPAC Basic Options Window - Sort Holdings 



Virtua Profiler/OPAC Parameters (v. 16.1)  

 PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 

140 

 
When the Sort Holdings List by Location Name check box is selected, the list of 
holdings will be sorted alphabetically by location name. 
 
When the Sort Holdings List by Location Name check box is NOT selected, the list of 
holdings will be sorted by location code. 
 

4.8 Sorting Patrons by Name, 

Birthdate, and Barcode 

 
In a patron name browse search, when patron headings with identical names are found 
in the subfield $a of the 100, 110, or 111 field, Virtua will use the Sort Patrons by 
Name, Birthdate, and Barcode setting on the OPAC Basic Options window (Figure 4-9) 
to determine the sort order on the Browse window. 
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Figure 4-9. OPAC Basic Options Window - Patron Sort 
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When the Sort Patrons by Name, Birthdate, and Barcode check box is selected, Virtua 
will sort the patron names first by name, secondly by date of birth, and thirdly by 
barcode number (from tag 015). 
 
When the Sort Patrons by Name, Birthdate, and Barcode check box is NOT selected, 
Virtua will sort by name only and will use the order the patron entered the system.  
 

Note: Changes to the Sort Patrons… setting will take effect only after you run 
ReIndexPatrons.sh. 

 
 

4.9 Removing Apostrophes from Patron 

Name Browse Searches 

 
The Remove Apostrophe for Patron Name Browse check box on the OPAC Basic 
Options window (Figure 4-10) lets you specify how Virtua handles patron name browse 
search terms that contain an apostrophe character (’). 
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Figure 4-10. OPAC Basic Options Window - Remove Apostrophe 
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When the check box is selected, Virtua treats a browse search for a patron name 
containing an apostrophe the same as a search with no apostrophe. This means a 
browse search for the patron name “O’Neal” will yield the same results as a browse 
search for the patron name “Oneal.” 
 

Important: After you change this setting, you must run the scripts LoadSortMap.sh 
and ReIndexPatrons.sh and then restart psdriver.exe for the change to take effect. 

 
 

4.10 Enabling Collection Group Filters 

for Browse and Heading Searches 

 
The setting “Allow collection group filters for browse/heading” on the OPAC Basic 
Options window (Figure 4-11) lets you enable a Collection Group filter button on the 
Browse and Heading tabs on the search window in the Virtua client. 
 
When the check box is selected, a Collection Groups button appears on the Browse 
and Headings tabs of the Search window of the Virtua client. Clicking this button 
opens a window where you can choose collection groups to use to filter the search.  
 
The collection groups available to filter browse and heading searches are those defined 
by the Collection Code Definitions parameter in the Virtua Profiler. See the Virtua 
Profiler/Cataloging Parameters User’s Guide for information on this parameter. 
 
 

Important: After you change this setting, you must run the script 
PopulateCollectionGroupFilters.sh and restart psdriver.exe for the change to take 
effect. See the System Management: OPAC User’s Guide for information on running this 
script. 
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Figure 4-11. OPAC Basic Options Window - Allow collection group filters for browse/heading 
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4.11 Enabling Item Class Filters for 

Browse and Heading Searches 

 
The setting “Allow item class filters for browse/heading” on the OPAC Basic Options 
window (Figure 4-12) lets you enable an Item Class filter button on the Browse and 
Heading tabs on the search window in the Virtua client. 
 
When the check box is selected, an Item Class button appears on the Browse and 
Headings tabs of the Search window of the Virtua client. Clicking this button opens a 
window where you can choose item classes to use to filter the search.  
 
The item classes available to filter browse and heading searches are those defined by 
the Item Class Definitions parameter in the Virtua Profiler. See the Virtua 
Profiler/Circulation Parameters User’s Guide for information on this parameter. 
 

Important: After you change this setting, you must run the script 
PopulateItemClassFilters.sh and restart psdriver.exe for the change to take effect. 
See the System Management: OPAC User’s Guide for information on running this script. 
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Figure 4-12. OPAC Basic Options Window - Allow item class filters for browse/heading 
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4.12 Setting the Maximum Size of 

Result Sets for Holdings and Patron 

Keyword Searches 

 
On the OPAC Basic Options window, Virtua pre-sets the maximum size of a result set 
for either a holdings or patron keyword search at 10,000 for performance reasons. You 
can raise or lower this limit as you wish by editing the default value in the Holdings 
Keyword Search Max Number of Hits field and/or the Patron Keyword Search Max 
Number of Hits field (Figure 4-13). 
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Figure 4-13. OPAC Basic Options Window - Keyword Search Max Hits 
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4.13 Specifying the Number of Lines 

per Record in the List of Titles 

 
On the OPAC Basic Options window, Virtua pre-sets the number of lines that display 
per record on the List of Titles window at 4. You can raise or lower this number as 
you wish by editing the default value in the Number of Lines per Record in List of 
Titles Display field (Figure 4-14). 
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Figure 4-14. OPAC Basic Options Window - Number of Lines per Record 
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4.14 Setting Default Result Set Sorting 

 
You can determine default values for sorting the result sets that are displayed on the 
List of Titles window in the Virtua client. The Default Result Set Sorting settings on 
the OPAC Basic Options window let you specify values for three options: 

 Sort type 

 Sort order (either ascending or descending) 

 Maximum number of hits to sort. 
 
To set Default Result Set Sorting options,  
 
1. On the OPAC Basic Options window (Figure 4-15), go to the Default Result Set 

Sorting area. 
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Figure 4-15. OPAC Basic Options Window - Sort Order of Results 
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2. In the Sort Type drop-down list box, select the value by which you want result sets 
sorted. Choose from the following: Author; Call Number; No Sort; Publishing 
Date; Publishing Date, Author; Publishing Date, Title; and Title. 

3. Select the radio button that reflects the desired sort order for the selected sort type. 
Ascending order means “alphabetical,” “lowest number first,” or “earliest date first.” 

4. In the Maximum Number of Hits field, type the maximum number of results that 
you want to be sorted according to your specified criteria. If your result set exceeds 
this number, your result set will not be sorted. 

Note: If you type 0 (zero) or leave the field blank, your result set will not be 
sorted. 

 

4.15 Setting Default Item Sorting 

 
You can determine the default sort order of items that are displayed in the Virtua 
client. The items will be sorted in the display box on the Items tab of the View 
Bibliographic Record window and on the Items tab of the View Holdings Record 
window. 
 
The Default Item Sorting setting on the OPAC Basic Options window lets you order 
the list of items by location, copy number, and units. You can set a primary, secondary, 
and tertiary sort order. In addition, for a given sort type, such as location, you can 
specify whether the sorting for that type will be in ascending or descending order. You 
can also choose whether the location used to sort items is the shelving location or the 
owning location, and whether to sort by location code or location name. 
 
To set the default values for sorting items that appear onscreen,  
 
1. On the OPAC Basic Options window (Figure 4-16), go to the Default Item Sorting 

area. 
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Figure 4-16. OPAC Basic Options Window - Default Item Sorting 
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2. Accept the default settings or change them by doing the following:  
 

a) Choose the sort order of the following item elements: Location, Units, and 
Copy Number. The software will use as the primary sort the element that 
appears first in the Sort Order list box, and it will use as the secondary and 
tertiary sorts the elements that appear second and third. 

 

Hint: To move an item element up or down in the Sort Order list, click the up 
and down arrow buttons, or press CTRL + Up Arrow and CTRL + Down 
Arrow on your keyboard. 

 
For example, if your settings are the default settings as shown in Figure 4-16, 
the software will sort items by location first. If any two items have the same 
location, the software will sort the two items by units. If any two items have 
the same location and same units, the software will sort by copy number. 

 
b) For each item element, check whether you want the software to sort the 

element in ascending or descending numerical order. (Note that the location 
sort uses the location code, not the name.) 

 

Hint: Ascending order means the lowest number is first. 

 
 
3. To specify that the location used for sorting is the item’s shelf location, select the 

Location is shelf location check box. If this check box is not selected, Virtua uses the 
owning location when sorting items by location.  

 
4. To specify that the location name be used for sorting, select the Use location name 

check box. If this check box is not selected, Virtua uses the location code when 
sorting items by location.  
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4.16 Setting the Maximum Size of 

Result Sets for Bibliographic 

Keyword Searches 

 
The Max(imum) Bib Keyword Search Result Set Size settings on the OPAC Basic 
Options window let you determine the size of bibliographic keyword result sets.  If 
you specify a value in the Maximum Number of Hits field, the Virtua server will 
truncate any results returned from a bibliographic keyword search that exceed the 
value.  
 

Note: If a results set is truncated, the results that are displayed will depend on the 
database’s default keyword sort. For information on setting a default keyword sort 
type, see the Virtua System Management: OPAC User’s Guide. 

 
To specify the size of bibliographic keyword result sets,  
 
1. On the OPAC Basic Options window (Figure 4-17), go to the Max Bib Keyword 

Search Results Set Size area. 
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Figure 4-17. OPAC Basic Options Window - Bibliographic Keyword Search Results  
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2. In the Maximum Number of Hits text box, type the maximum number of results 

you want to allow in a keyword result set. 
-OR- 
If you do not want to set a maximum number, select the No Upper Limit check 
box. 

 

Note: Default sorts do not work on result sets greater than 500 hits. 

 

4.17 URL Settings for Enhanced 

Searching 

 
The Solr URL and Chamo Base URL settings (Figure 4-18) specify information about 
the Chamo server, which must be in place to use Virtua’s Holdings Keyword search 
and Patron (keyword) search.  
 
The Solr URL field specifies the URL of your Chamo's Solr indexer, which is used by 
Virtua for both patron and holdings keyword search functionality. This URL is 
typically formed by adding “/solr” to the end of Chamo's Base URL.  

 Due to Solr's default access restrictions, if the Virtua database and the Chamo 
instance are running on the same server, it is usually necessary to use “localhost” as 
the hostname for this URL to allow the Virtua server software to contact the 
indexer successfully.  

 If the Virtua database and the Chamo instance are running on different servers, this 
URL must point to the proper host, and Chamo must be configured properly to 
allow Solr access from the database server.  

 
Once set, do not remove or modify this URL without cause. 
 
The Chamo Base URL field specifies the URL of your Chamo installation. This URL 
should start with “http://,” followed by the hostname and port that are used to 
connect to your main Chamo webpage. Once set, do not remove or modify this URL 
without cause. 
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Figure 4-18. OPAC Basic Options Window - Solr and Chamo Settings 
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4.18 Configuring the URL Setting for 

Open Skies 

 

Important: The Open Skies URL setting MUST be configured correctly and the Open 
Skies-enabled Chamo instance must be running for you to start psdriver.exe, which is 
necessary to use the Virtua client, or 3mdriver.exe, which is necessary to run Self 
Check machines, or circbackup.exe, which loads and processes transaction files from 
the Circulation Backup System. 

 
The Open Skies URL field specifies the URL of your Chamo's Open Skies web 
services—the REST APIs—which are used by Virtua to perform a variety of web-
based circulation and cataloging tasks. This URL is typically formed by adding “/rest/” 
to the end of Chamo's Base URL. This value must be set correctly and the Open Skies-
enabled Chamo instance must be running prior to starting several essential executables 
such as psdriver.exe. These executables reference this value on initialization to locate 
your Chamo's web services for use. 
 
Once set, do not remove or modify this URL without cause. 
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Figure 4-19. OPAC Basic Options Window - Open Skies URL Setting 
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4.19 Linking Virtua with a VITAL 

Instance 

 
Virtua and VITAL can be integrated. To link your Virtua instance with a VITAL 
instance, you must populate the VITAL Base URL and VITAL Authentication fields 
(Figure 4-20). Populating these fields enables an Add/Modify Digital Content right-
click option on the View Bibliographic Record window in the Virtua client, which lets 
you add or change the contents of the record’s 856 tag.  
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Figure 4-20. OPAC Basic Options Window - VITAL Settings 
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VITAL Base URL - This field must contain the URL of your VITAL instance; e.g., 
http://www.host.com:9999/VITAL/Search 
 
Fedora Admin Username - The admin username for your VITAL Fedora instance. 
 
Fedora Admin Password - The password for your Fedora admin user. 
 

4.20 System Process Authorization 

 
The System Process Authorization provides authorization information that allows 
different components of Virtua to operate.  
 

Important: You MUST configure the System Process Authorization settings for 
Virtua to be able to run vital processes such as circulation backup and SelfCheck. You 
may still run psdriver.exe if you do not configure these settings. 

 

http://www.host.com:9999/VITAL/Search
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Figure 4-21. OPAC Basic Options Window - System Process Authorization 
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Note: The System Process Authorization settings should correspond to the API 
Configuration settings in Chamo. Contact Customer Support if you need help 
configuring these settings. 

 

 REST Authorization URL - The URL used to authorize REST services. This 
must be the full URL, which usually ends in the string 
/rest/oauth/token?scope=all&grant_type=client_credentials. 
 

 System Process Username - The username used to run system processes. This 
must be the same as the System Process Username configured in Chamo. 
 

 System Process Password - The password used for the system process user 
defined in System Process Username. 
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5. Working with the Client Keyword 

Search Filters Parameter 

  
The Client Keyword Search Filters parameter gives you a way to customize two types 
of keyword search filters, Format and Nature of Content, which are available on the 
Search Filters window in the Virtua client (Figure 5-1).  
 
 

 

Figure 5-1. Virtua Client - Search Filters Window 

 
Using the Client Keyword Search Filters parameters (Figure 5-2), you can… 
 

 Edit the list of descriptions for the Format filter type and Nature of Contents filter 
type or translate them into ONE language. 
-AND- 

 Define which fixed fields are to be associated with each filter description listed for 
the Format filter type and Nature of Contents filter type. 
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Note: Via parameters on the Global Settings tab, you can also translate descriptions 
for two other filters available on the Search Filters window in the Virtua client: 
Language and Place of Publication (using the LC Country Configuration parameter). 
See the Virtua Profiler/Global Parameters User’s Guide for information about these 
settings. 

 
 

   

Figure 5-2. OPAC Tab - Client Keyword Search Filters Parameter 

 
To customize the Formats parameter’s list of Format descriptions, 
 
1. In the “tree” on the OPAC tab, double-click Client Keyword Search Filters, and 

then double-click Formats. 
 

The Format Filters window appears (Figure 5-3). 
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Figure 5-3. Format Filters Window 

 
2. Select and then click each Format description in order to edit or translate the label. 

 
3. Define the fixed fields to be associated with each Format type as appropriate: 

 Click in the Record Type column to select the Type code. 

 Click in the Bib Level column to select the Bib Level. 

 Click in the Item Form column to select the Form. 

 Click in the Material Type column to select the category of material. 
 
4. If desired, add a new Format description by clicking the Add button. 

 
5. Save your changes. 

 

Hint: You can use the script PopulateMarc21FormatFilter.sh to load a file of 
format filters into this window. See the System Management: OPAC User’s Guide for 
information on this script.  
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To customize the Nature of Contents parameter’s list of descriptions, 
 
1. In the “tree” on the OPAC tab, double-click Client Keywords Search Filters, and 

then double-click Nature of Contents. 
 
The Nature of Contents window appears (Figure 5-4). 
 
 

 

Figure 5-4. Nature of Contents Window 

 
2. Select and then click each Nature of Contents description in order to edit or 

translate the label. 
 
3. Define the code, which resides in the 008 tag, to be associated with each Nature of 

Contents description by clicking in the Code column to edit the code. 
 
4. If desired, add a new Nature of Contents description by clicking the Add button. 
 
5. Save your changes. 
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6. Appendix A - The Validation 

Process in the MARC View Editor 

 

The software performs different types of validation at different times in the MARC 
View Editor. 

When You Are Editing a Field, the Software Checks that:  

 All Tag Numbers are numeric 

 The Tag Number has three digits 

 The Tag Indicators have two characters. 

 Each Tag Occur character is a star (*) or a number 

 All First tags are numeric 

 All Last tags are numeric 

 All General Column Widths are numeric 

 All Item Column Widths are numeric 

(The software displays a diagnostic error message.) 

 

When You Are Exiting a Field, the Software Checks that: 

 The list of Tag Numbers are all < 010 (and may include 999) or are all >= 010 

 The Tag Number is > 0 

 The Tag Occur is two stars (**) or contains no stars 

 The Tag Occur is two stars or is a number > 0 

 If in the list of Tag Numbers there exists a Tag Number < 010 or equal to 999, 
then  

 The Fixed Field has one and only one % digit 

 The Fixed Field has a period (.) sometime (but not immediately) after the % 

 The Fixed Field has a number < 9999 between the % and period 

 The Fixed Field has a number after the period that is >= the number before 
the period, but that is < 9999 
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 If in the list of Tag Numbers a Tag Number exists that is >= 010 which is not 
9999, then 

 The Subfield has one and only one % digit 

 The Subfield has an alphanumeric digit after the % digit 

 The Subfield has a star (*) or non-zero numeric digit after the alphanumeric 
digit 

 The Format Types is an alphabetical digit followed by 0 or more, comma, 
alphabetical digit pairs 

 The Format Bib Levels is an alphabetical digit followed by 0 or more, comma, 
alphabetical digit pairs 

(The software displays an error message for invalid cases and selects the invalid text.) 

 

When You Are Closing the Format List Editing Panel, the Software Checks 
that:  

 All Format Names are unique 

 All Formats have at least a Format Type or Format Bib Level 

(The software displays an error message for invalid cases and selects the invalid text.) 

 

When You Are Closing the Language List Editing Panel, the Software Checks 
that: 

 All Language Names are unique 

(The software displays an error message for invalid cases and selects the invalid text.) 

 

When You Are Saving Your Work, the Software Checks that:  

 There is at least one Tag or a Non-Normal Tag specified for each Tag Label in 
each Format 

 No Tag Label has a Tag List containing the same number, indicators and 
occurrence in each Format 

 No Fixed Field or Subfield has a Value List containing duplicate Values in each 
Format 

 The General Column Width Total and Item Column Width Total are 100% for 
each Format 

 Every General and Item Column has a Column Width in each Format 

 Every Item Column has an Item Field 

(The software displays an error message for invalid cases.) 
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7. Appendix B - Changes in this 

Guide  

 

7.1 Changes for Version 16.1 

 
No changes were made. 
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